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1 TM Integration Guide for SAP Digital
Supply Chain Management, Edition for
SAP S/4HANA

The SAP Digital Supply Chain Management, edition for SAP S/4HANA allows you to use the SAP S/4HANA
Supply Chain for transportation management (TM) capability side by side with your ERP system.

In this integration scenario, you use SAP Digital Supply Chain Management, edition for SAP S/4HANA to
perform transportation management, while performing all other processes in a separate system (SAP ECC or a
second SAP S/4HANA system), as shown by the following graphic:

ERP System SAP Digital Supply Chain Management,
(SAP ECC or SAP S/4HANA) Edition for SAP S/4HANA

This guide describes the required steps to run TM side by side with your existing ERP system.

System Requirements

System Release
™ SAP Digital Supply Chain Management, edition for SAP S/
4HANA 2021
ERP SAP ERP 6.0 with enhancement package 7 or 8
SAP S/4HANA 2021
i Note

This guide describes the required settings to integrate the TM capability of the edition of SAP Digital Supply
Chain Management for SAP S/4HANA with your ERP system. Depending on your business processes,
additional configuration settings and master data may be required.
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i Note

This guide provides links and navigation paths to the most up-to-date version of the documentation on the
SAP Help Portal. Therefore, whenever you access information using these links, you should choose your
specific release from the drop-down menu there.

Similarly, if you are running an SAP ERP system and a link to further information leads you to the Product
Assistance for SAP S/4HANA, you should substitute that with the SAP Library for SAP ERP. Apart from the
product names, the navigation paths are the same.

Naming Conventions

This implementation guide uses the following naming conventions:

* The term ERP system refers to your SAP ERP (SAP ECC) system or a separate SAP S/4HANA system in
which you're running ERP.

* Theterm TM system refers to the edition of SAP Digital Supply Chain Management for SAP S/4HANA in
which you're running TM.
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2

Provides details about the changes made in this document.

Document History

Make sure you are using the latest version of this document. The latest version is available at http://

help.sap.com/dscedition.

The following table provides an overview of the most important document changes.

Version

Date

Description

1.2

2022-10-03

Changes made to chapter Application
Configuration for SOA Manager,

major changes made to chapter
Technical Configuration for ALE/IDoc;
major changes made to chapter

Basic Settings for System Landscape;
major changes made to chapter
Troubleshooting SOA Manager and
WSRM Communication; minor changes
made elsewhere.

11

2022-05-25

Minor corrections made in many areas.

1.0

2022-02-23

First version of this guide.
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3 Implementation Overview

Running TM side by side an ERP system requires an implementation project involving IT experts as well as the
affected business process owners and other relevant stakeholders.

The steps involved in such an implementation project include:

* Configuring master data and settings
* Monitoring distributed data
* Handling errors

The following figure provides an overview of the master data distribution options and methods:

DRF
Product Product
DRF
A Sad Business Partner Business Partner BT
Vendor Vendor

Plant / Shipping L ocation
Point DRF

Customer/vendor integration (CVI) creates business partner master data from customers and vendors in
ERP, and creates customers and vendors from business partner master data in TM.

* The business partner is the leading entity in TM.

* Business partner addresses can be used to create locations in your TM system.

Master data is replicated from your ERP system to your TM system as follows:

Web services are used to transfer plants and shipping points as location objects to your TM system.

Web services are used for replicating business partners and locations to your TM system.

If your ERP system is an SAP ECC system, IDoc is used for replicating materials to your TM system. If your
ERP system is an SAP S/4HANA system, Web services are used.

TM Integration Guide for DSC Edition
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4 Interfaces for TM Integration

The following graphic shows the interfaces through which data is transferred between your ERP system and
your TM system.

SAP Digital Supply Chain Management, Edition for
SAP S/4AHANA

ERP

™
Web Service:
BusinessPartnerSUITEBulkReplicateRequest
1Doc: Material Master (MATMASO1)

Plant/ Web Service: LocationBulkReplicationRequest _ PI_.':lnt/ .
Shipping Point Shipping Foint
Location

Web Service:
IntracompanyTransportationRequestRequest Order-Based
Sales Order Transportation
Requirement
Web Service:
Purchase Order IntracompanyTransportationRequestRequest
Stock Transfer Order

Inbound/Qutbound Web Service: OutboundDeliveryBulkCreateRequest
Delivery

YL

Web Service:
TransportationOrderLoadingAppointmentNotification

Yard Request

Delivery-Based
Transportation
Requirement

Freight Order

Web Service:
Purchase Order TransportationOrderSUITEInvoicingPreparationReguest Freight Settlement

Service Entry Sheet Document

i Note

If your ERP system is an SAP S/4HANA system, materials can also be transferred using a Web service.

Master data objects are transferred using data replication framework (DRF). DRF uses Web services or IDoc as
technology.
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5 Configuration of Master Data Replication

Configure the required settings to integrate and replicate business objects between your ERP and TM systems.
The steps in this section explain how to perform the following activities:

¢ Activate business functions to enable point-to-point communication and master data replication

i Note

You only need to activate business functions if your ERP system is an SAP ECC system. In SAP S/
4HANA all required business functions are always on.

¢ Define logical systems and create Remote Function Call (RFC) connections to replicate business objects
between SAP systems through Application Link Enabling (ALE)
¢ Create distribution models and partner profiles to replicate data between ERP and TM

¢ Configure the data replication framework (DRF) to define which business objects you want to replicate and
which filter criteria you want to use

i Note

You can replicate a business object only if all references by the business object also exist in the
destination system (for example, materials could reference sales data). When configuring your system,
ensure that every plant, storage location, and other relevant object that is referenced by a business
object in the source system also exists in the destination system. Alternatively, you can delete the
reference before transferring the data.

5.1 Basic Settings for System Landscape

5.1.1 Activate Business Functions in ERP

To enable your ERP system to communicate with your TM system, you must activate business functions.
These are individual standard applications and industry solutions in your ABAP-based SAP system. With the
business functions, SAP provides new features and enhancements in self-contained units for your existing SAP
installations.

Context

Perform this step only if you're running SAP ERP 6.0 with enhancement package 7 or 8. The business functions
named here are already activated in SAP S/4HANA systems.

TM Integration Guide for DSC Edition
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Procedure

1. Inyour ERP system, open transaction SF\b.

2. Activate the following business functions:

Business Function Description Details
DRF_FOUNDATION Data Replication To activate this business function in
SAP ERP 6.0 EhP 7, check SAP Note
2952509
FND_SOA_REUSE_1 Improvements for SOA Reuse Enables you to use Web Services
Functions Reliable Messaging (WSRM).
i Note

Business function DRF_FOUNDATI ONis shipped in SAP ERP 6.0 with enhancement package 8 and is
not available in earlier enhancement packages. It enables material master changes to be replicated
when the material is saved. If the business function has not been activated or is not available, the
system only writes a change pointer when a material is saved. You can replicate all materials that
have a change pointer by using transaction DRFOUT or report RDRF_MESSAGE_QUT (replication mode
Changes). We recommend scheduling a job to run the report RDRF_MESSAGE_QOUT periodically to
replicate all material changes since the previous replication.

i Note

For more information on activating business functions for DRF in SAP ERP, see chapter 20a of SAP
Note 2769186 # .

5.1.2 Activate Business Functions in TM

To enable your ERP system to communicate with your TM system, you need to activate business functions.
These are individual standard applications and industry solutions in your ABAP-based SAP system. With the
business functions, SAP provides new features and enhancements in self-contained units for your existing SAP
installations.

Context

In your TM system, business functions should already be active. For more information, see SAP Note
2240360 .

TM Integration Guide for DSC Edition
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Procedure

1. Inyour TM system, launch transaction SFWb.

2. Ensure the following business functions are activated:

Business Function Description Details
DRF_FOUNDATION Data Replication
FND_SOA_REUSE_1 Improvements for SOA Reuse Enables you to use Web Services
Functions Reliable Messaging (WSRM).
i Note

For more information on activating business functions for DRF in TM, see chapter 20 of SAP Note
27691864 .

5.1.3 Configure Logical Systems in ERP

Configure logical systems in your ERP system to enable communication between your ERP and TM systems.

Context

In your ERP system, you need to:
¢ Define alogical system for your ERP system and assign it to a client.

¢ Define alogical system for your TM system and client.

- Recommendation

We recommend that a logical system adheres to the naming convention <SSS>CLNT<CCC>, where SSS is
the 3-character system ID and CCC is the client.

Procedure

1. Logonto your ERP system.
2. Runtransaction SALE (Display ALE Customizing).

3. Define a logical system for your ERP system and client by choosing | Basic Settings ¥ Logical Systems
» Define Logical System 3.

4. Save your entries and exit the activity.

5. Assign the ERP logical system to a client by choosing | Basic Settings ¥ Logical Systems » Assign Logical
System to Client 3.

TM Integration Guide for DSC Edition
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6. Select the client in which you're running ERP and assign the logical system that identifies the ERP system
and client.

7. Save your settings and exit the activity.

8. Define a logical system for your TM system and client by choosing |# Basic Settings » Logical Systems
» Define Logical System 1.

9. Save your entries and exit the activity.

5.1.4 Configure Logical Systems in TM

Configure logical systems in your TM system to enable communication between your TM and ERP systems.

Context

In your TM system, you need to:

* Define alogical system for your TM system and assign it to a client.
* Define alogical system for your ERP system and client.

- Recommendation

We recommend that a logical system adheres to the naming convention <SSS>CLNT<CCC>, where SSS is
the 3-character system ID and CCC is the client.

Procedure

1. Logontoyour TM system.
2. Runtransaction SALE (Display ALE Customizing).

3. Define a logical system for your TM system and client by choosing | Basic Settings » Logical Systems
» Define Logical System 3.

4. Save your entries and exit the activity.

5. Assign the TM logical system to a client by choosing |+ Basic Settings » Logical Systems » Assign Logical
System to Client 3.

6. Select the client in which you're running TM and assign the logical system that identifies the TM system
and client.

7. Save your settings and exit the activity.
8. Define a logical system for your ERP system and client by choosing | Basic Settings ¥ Logical Systems
» Define Logical System 3.

9. Save your entries and exit the activity.

TM Integration Guide for DSC Edition
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5.1.5 Create RFC Users in ERP and TM

Create an RFC user with the required authorizations in your TM and ERP systems to enable successful
communication between the systems.

Procedure

1. Launch transaction SU01 in your ERP system and identify the user.
2. Onthe Logon Data tab, select user type Service and specify a password.

3. Use transaction PFCGto create a role with the necessary authorizations for this user. You must specify the
following authorization objects for the RFC user:

°* S RFC
°* B ALE MODL
* C_PDC
* M MBEG BWA
* M MVBEG WM
* C_AFRU AWK
° SAP BC WEBSERVI CE_ADM N
4. Launch transaction SU01 in your TM system and identify the user.
5. Onthe Logon Data tab, select user type Service and specify a password.
6. Intransaction PFCG specify the following authorization objects for the RFC user:
* S RFC
* B _ALE_MODL
* SAP BC WEBSERVI CE_ADM N

* T_ADM Nwith ACTVT = H1 (Deactivate). This deactivates TM specific authorization checks, which
reduces memory allocation and improves the system performance for the processing of TM
documents.

5.1.6 Create RFC Connection from ERP to TM

Create an RFC connection from your ERP to your TM system to enable RFC communication between the two
systems.

Context

The RFC infrastructure is used both for synchronous remote function calls and for asynchronous IDoc
messages.

For details on how to configure RFC connections securely, see:

TM Integration Guide for DSC Edition
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* The RFC Communication Between SAP Systems section of the RFC/ICF Security Guide for SAP NetWeaver
on the SAP Help Portal. Go to http://help.sap.com/netweaver and use the Guide Finder for SAP NetWeaver
and ABAP Platform.

* Securing Remote Function Calls (RFC) "

Procedure
1. Log on to your ERP system.
2. Runtransaction SM69 and create the RFC connection to the TM system if it doesn't exist yet.
3. To create the RFC connection, select ABAP Connection and choose (] (Create).
4. Enter the following data and then press :
Field Value
Destination Specify the logical system of the TM system as the
destination.
Connection Type 3

5. On the Technical Settings tab, make the following settings:
a. Forload balancing, select Yes.
b. Enter the target system, message server, and group.

i Note

If necessary, copy this information from the system entry properties in SAP Logon.

6. Onthe Log On & Security tab, define the following settings:

a. Thelanguage and client of the target system.
b. The logon data for the RFC user that you created in Create RFC Users in ERP and TM [page 13].
c. Set Trust Relationship to Yes.

7. Onthe Unicode tab, make sure the connection type is Unicode.
8. Save your RFC connection.

9. Verify your settings by choosing Remote Logon and Connection Test.

TM Integration Guide for DSC Edition
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5.1.7 Create RFC Connection from TM to ERP

Create an RFC connection from your TM to your ERP system to enable RFC communication between the two
systems.

Context

The RFC infrastructure is used both for synchronous remote function calls and for asynchronous IDoc
messages.

For details on how to configure RFC connections securely, see:

* The RFC Communication Between SAP Systems section of the RFC/ICF Security Guide for SAP NetWeaver
on the SAP Help Portal. Go to http://help.sap.com/netweaver and use the Guide Finder for SAP NetWeaver
and ABAP Platform.

*  Securing Remote Function Calls (RFC)

Procedure
1. Logontoyour TM system.
2. Runtransaction SM69 and create the RFC connection to the ERP system if it doesn't exist yet.
3. To create the RFC connection, select ABAP Connection and choose (] (Create).
4. Enter the following data and then press :
Field Value
Destination Specify the logical system of your ERP system as the
destination.
Connection Type 3

5. Onthe Technical Settings tab, make the following settings:
a. Forload balancing, select Yes.
b. Enter the target system, message server, and group.

i Note

If necessary, copy this information from the system entry properties in SAP Logon.

6. Onthe Log On & Security tab, define the following settings:
a. Thelanguage and client of the target system.

b. The logon data for the RFC user that you created in Create RFC Users in ERP and TM [page 13].
c. Set Trust Relationship to Yes.

On the Unicode tab, make sure the connection type is Unicode.

8. Save your RFC connection.
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9. Verify your settings by choosing Remote Logon and Connection Test.

5.1.8 System Landscape Directory

A system landscape consists of a number of hardware and software components that depend on each other for
installation, software updates, upgrades, and demands on interfaces.

The System Landscape Directory of SAP NetWeaver (SLD) serves as a central information repository for
your system landscape. Therefore, when performing a new ERP-TM integration, the SLD is a key actor in the
inter-system communication.

You can find more information at the following links:

* System Landscape Directory - Basics, Scenarios & Best Practices# on the SAP Support Portal.
*  SAP Note 1978857 ¥ .

5.1.8.1 Maintain SLD Access Data in ERP

Business systems require a connection to the SLD server to obtain their name from the SLD. The business
system name is an identifier that the system uses in the header of the message sent to the receiving system.

Context

The connection to the SLD is established by creating an RFC destination and calling a registered server
program (which is defined on the AS Java RFC engine of the SLD server). The server program is called with the
HTTP address as a parameter that is maintained with transaction SLDAPI CUST.

- Recommendation

For security reasons, you can also secure your SLD connection with HTTPS.

Procedure

1. Logonto your ERP system.
2. Runtransaction SLDAPI CUST (Display SLD Access Data).

3. Tocreate a new entry, select Access to SLD Server Using HTTP and choose Connection Parameter Entered
Here.

4. Specify the following data and then press|[Ent er |
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Field

Value

Alias Name [SLD Server Host Alias Name]

Primary x (checked)

Host Name [Host name of your SLD server]

Port No. [HTTPS port number of the SLD server]
User [SLD access user]

Password [SLD access user password]

5. Save your entries.

5.1.8.2 Maintain SLD Access Datain TM

Business systems require a connection to the SLD server to obtain their name from the SLD. The business
system name is an identifier that the system uses in the header of the message sent to the receiving system.

Context

The connection to the SLD is established by creating an RFC destination and calling a registered server
program (which is defined on the AS Java RFC engine of the SLD server). The server program is called with the
HTTP address as a parameter that is maintained with transaction SLDAPI CUST.

- Recommendation

For security reasons, you can also secure your SLD connection with HTTPS.

Procedure

1. Logontoyour TM system.

2. Runtransaction SLDAPI CUST (Display SLD Access Data).

3. Tocreate a new entry, select Access to SLD Server Using HTTP and choose Connection Parameter Entered

Here.
4. Specify the following data and then press :
Field Value
Alias Name [SLD Server Host Alias Name]
Primary x (checked)
Host Name [Host name of your SLD server]

TM Integration Guide for DSC Edition
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Field Value

Port No. [HTTPS port number of the SLD server]
User [SLD access user]
Password [SLD access user password]

5. Save your entries.

5.1.8.3 Define SLD Data of Business Systems

You use this procedure to name the business system and all systems that are part of the system landscape.

Procedure

Log on to your TM system.

In Customizing for Transportation Management, choose | Integration ¥ Define SLD Data of Business
Systems 3.

In the Buffer for SLD Data of Business Systems screen, create a new entry for each system that is part of
your system landscape. For example, create new entries with the following values for your TM system and
your ERP system:

Business System Logical System Manual Maint.
<System ldentifier>_<dient <TM Logi cal Systen®, for Flagis not set
Nunber >, for example, TML_001 example, TMLCLNTOO01
<System ldentifier> <dient <ERP Logical Systenp, for Flag set (event raised)
Nunber >, for example, ERP_001 example, ERPCLNT001

i Note

In the activity Configure Your Central System [page 21], you may want to use the same value

for Business System and Business System ID. The maximum number of characters allowed for the
Business System ID is 8. Therefore, we recommend you choose a Business System of 8 characters or
less here.

- Recommendation

We recommend that a logical system adheres to the naming convention <SSS>CLNT<CCC>, where SSS
is the 3-character system ID and CCC is the client.

4. Save your entries.

18
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5184 Configuring, Working with, and Administering the
SLD

You must register your business systems in the SLD.

Prerequisites

You have performed the activities described in Connecting Systems to the SLD in the SAP Library for SAP
NetWeaver on the SAP Help Portal under |[» Application Help # SAP NetWeaver Library: Function-Oriented View
» Solution Life Cycle Management » Configuring, Working with and Administering System Landscape Directory
» Connecting Systems to the SLD 3

* Connecting AS ABAP Systems to the SLD

* |k Connecting AS ABAP Systems to the SLD » Setting Up the SLD Data Supplier for AS ABAP-Based
Systems 3

e |k Connecting AS ABAP Systems to the SLD  Using SLD API for AS ABAP-Based Systems 3

Procedure

1. You must configure systems that are installed in your system landscape to periodically send data to the
SLD. For more information, see Connecting Systems to the SLD.

2. With the SLD you can view and manage technical systems, landscapes, business systems, products, and
software components. You can find more information about this under Working with SLD.

5.1.9 Technical Configuration for SOA Manager

SOA Manager is a collection of tools for maintaining ABAP Web service-relevant entities. The following pages
describe how you should configure it. SOA stands for "service-oriented architecture".

Prerequisites

* ForaTM and ERP system, you have ensured that the business function FND_SOA REUSE _1 is activated.
This enables Web Services Reliable Messaging (WSRM) usage in these systems. For more information, see
Activate Business Functions in ERP [page 9] and Activate Business Functions in TM [page 10].

* You have set up the technical configuration of the Web service runtime environment in all relevant systems
(TM and ERP). For more information on configuration of Web service runtime, see SAP Note 1043195,

* You have configured the SLD to begin configuring WSRM.
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Further Information about SOA Manager

You can find detailed information on SOA Manager, including a Glossary of Terms for SOA Manager, in

the SAP Library for SAP NetWeaver on the SAP Help Portal under [ Application Help » SAP NetWeaver
Library: Function-Oriented View # Application Server » Application Server ABAP » Application Development
on AS ABAP » ABAP Workbench - Classic » ABAP Workbench Tools # ABAP Web Services ¥ Configuring Web
Services in SOA Manager 3.

5.1.9.1 Activate Point-to-Point Communication in ERP

Master data objects and transactional documents need to be transferred using Web services. You need to
enable this transfer in Customizing.

Procedure

1. Logontoyour ERP system.

2. In Customizing for Cross-Application Components, choose |+ Processes and Tools for Enterprise
Applications ¥ Enterprise Services  Point-to-Point Enablement for Asynchronous Enterprise Services
» Activate Support for Point2Point Communication 3.

3. Select Active and save your entry.

5.1.9.2 Activate Point-to-Point Communication in TM

Master data objects and transactional documents need to be transferred using Web services. You need to
enable this transfer in Customizing.

Procedure

1. Logontoyour TM system.

2. In Customizing for Cross-Application Components, choose [ Processes and Tools for Enterprise
Applications ¥ Enterprise Services  Point-to-Point Enablement for Asynchronous Enterprise Services
» Activate Support for Point2Point Communication 3.

3. Select Active and save your entry.
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519.3 Configure Your Central System

The central system is used to execute tasks on other systems within an ABAP landscape. As soon as a client
of an ABAP system is defined as a central system, other systems can pass control to the central system so
that different configuration tasks can be carried out in these managed systems from the central system. We
recommend that you use the system with the highest NetWeaver release as your central system.

Prerequisites

Ensure that the settings described in Defining Systems as Central Systems have been maintained. For
additional information, see the SAP Library for SAP NetWeaver on the SAP Help Portal under | Application
Help » SAP NetWeaver Library: Function-Oriented View ¥ Application Server ¥ Application Server ABAP

» Application Development on AS ABAP » ABAP Workbench - Classic » ABAP Workbench Tools » ABAP Web
Services ¥ Configuring Web Services in SOA Manager » Configuring Service Providers and Consumers

» Configuring Integration Scenarios ¥ Defining Systems as Central Systems 4.

Procedure
1. Log on to the system you want to use as your central system.
2. Runtransaction SOAMANAGER (SOA Manager).
3. Navigate to the Technical Administration tab and select SAP Client Settings.
4. Expand the Service Identifier section, select Edit and enter the following data:
Field Value
Organization Name [System description]
Business System Select Get from SLD to retrieve this information.
Business System ID Must match the system entry specified in table / SCvB/
TBUSSYS.
i Note

This is the business system that you defined in the

step Define SLD Data of Business Systems [page 18].

The maximum number of characters allowed for the
Business System ID field is 8.

5. Expand the Central Configuration section and choose Edit.
6. Check Central System.
Save your settings, and refresh your web browser.

The title Central SOA Management now indicates that your system is a central system. Within the central
system, the systems it manages are represented as domain systems.
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519.4 Configure a Management Connection to the Central
System

In each system that you want to be configured by a central system, you need to create a management
connection to the central system. The management connection is established from the system you want to
manage, but the process builds a bi-directional connection.

Procedure

For detailed information and instructions on how to configure a management connection to the central system,
please see Creating a Management Connection to the Central System in the SAP Library for SAP NetWeaver on

the SAP Help Portal under [ Application Help # SAP NetWeaver Library: Function-Oriented View  Application
Server ¥ Application Server ABAP » Application Development on AS ABAP » ABAP Workbench - Classic

» ABAP Workbench Tools » ABAP Web Services » Configuring Web Services in SOA Manager » Configuring
Service Providers and Consumers » Configuring Integration Scenarios » Creating a Management Connection
to the Central System 3.

5.1.9.5 Configure a Domain in the Central System

In the central system, domains are used to group systems that are managed by the central system. All
domain systems that you add to a domain have to share the same security and proxy settings for Web service
configuration. In the domain, you define the security and proxy settings for all connections within the domain.

Context

For detailed information and instructions on how to configure a domain in the central system, please see
Creating a Domain in a Central System in the SAP Library for SAP NetWeaver on the SAP Help Portal under

|+ Application Help » SAP NetWeaver Library: Function-Oriented View » Application Server » Application Server
ABAP » Application Development on AS ABAP » ABAP Workbench - Classic » ABAP Workbench Tools » ABAP
Web Services » Configuring Web Services in SOA Manager § Configuring Service Providers and Consumers

» Configuring Integration Scenarios ¥ Creating a Domain in a Central System 4.

Procedure

1. Logon to the system you want to use as your central system.
2. Runtransaction SOAMANAGER (SOA Manager).
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Navigate to the Technical Administration tab and select Domains.
On the Domains screen, select Create, enter the relevant data, and select Create again.
In the Domain Systems section, add the relevant system entries.

In the Profile section, choose the appropriate authentication method and transport security.

N oo s W

In the General section, change the State to Active, and select Save.

5196 Check Assignment of Systems to Domains

You need to ensure that the logical systems are assigned to the domain you created.

Procedure

1. Logon to your central system.
2. Runtransaction SOAMANAGER (SOA Manager).

3. Navigate to the Technical Administration tab and select Domain Systems or Provider Systems, depending
on your system.

4. Review each relevant Domain System ID. Depending on your system, you may need to select the Display
Domain System icon to do this.

5. Under the WSDL Access tab, see the section Logical System. You must ensure that the appropriate logical
system is specified in the corresponding field for each of the relevant systems assigned to the domain
that you created. For more information, see Configure Logical Systems in ERP [page 11], Configure Logical
Systems in TM [page 12], and Configure a Domain in the Central System [page 22].

5.1.9.7 Create and Assign Logon Data in Your Central
System

Context

You can either use this procedure below or create logon data directly within an integration scenario. For more
information, see Creating Connections for Integration Scenarios in the SAP Library for SAP NetWeaver on

the SAP Help Portal under | Application Help » SAP NetWeaver Library: Function-Oriented View » Application
Server ¥ Application Server ABAP » Application Development on AS ABAP » ABAP Workbench - Classic

» ABAP Workbench Tools » ABAP Web Services » Configuring Web Services in SOA Manager » Configuring
Service Providers and Consumers » Configuring Integration Scenarios » Creating Connections for Integration

Scenarios .
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Procedure

1. Run transaction SOAMANAGER (SOA Manager) in your central system.

2. On the Service Administration tab, choose Logon Data Management.

On the Maintenance tab, the system displays all logon data in a list.
3. Choose Create and specify a name, a description, and an authentication method.

If you choose User/Password or X.509 as the authentication method, you have to enter credentials.

The Type of the logon data is Template.
4. Onthe Assignments tab, assign the logon data to the provider system for which the logon data is valid.

5. To distribute the domain settings to your domain systems, start the change processor.

When the logon data is transported to a managed system, the logon data type is Central to mark that
it has been created in the central system. Central logon data can be used for central business scenario
configuration.

For more information, see Distributing Changes from the Central System to Domain Systems in the SAP
Library for SAP NetWeaver on the SAP Help Portal under |+ Application Help » SAP NetWeaver Library:
Function-Oriented View » Application Server ¥ Application Server ABAP » Application Development on
AS ABAP » ABAP Workbench - Classic » ABAP Workbench Tools » ABAP Web Services  Configuring
Web Services in SOA Manager » Configuring Service Providers and Consumers  Configuring Integration

Scenarios ¥ Distributing Changes from the Central System to Domain Systems .

5.1.10 Application Configuration for SOA Manager

1. Create one integration scenario configuration for each integration scenario. For more information, see
Integration Scenario Configuration [page 25].

2. Create and assign logon data. You only need to do this once for each managed system. For more
information, see Create and Assign Logon Data in Your Central System [page 23].

3. Start the change processor. For more information, see Start the Change Processor [page 27].

4. Create logical receiver determinations in SOA Manager (optional).
You should create logical receiver determinations for a service group if the service group contains a logical
receiver determination structure (LRD filter).

The local SOA Manager can be called directly out of the central system using | Central System
» Connections ¥ Open local SOAMANAGER 3.

A\ Caution

The following LRD filters have to be used for the service groups to enable the services. If the LRD filter
for a service group is not set, none of the contained services will be executed.
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Scenario Service Group LRD Filter Fields of LRD Filter

Location Integration LOCATI ON_REPLI CATE_RE LRD_SLD BSKEY BSKEY
Q

5.1.10.1 Integration Scenario Configuration

In a system landscape, one ABAP system can be defined as the central system. From this central system, entire
integration scenarios can be configured and the configurations can be distributed to all affected systems that
take part in the central configuration.

For more information on configuring integration scenarios, see Configuring Integration Scenarios in the

SAP Library for SAP NetWeaver on the SAP Help Portal under |+ Application Help  SAP NetWeaver

Library: Function-Oriented View » Application Server » Application Server ABAP » Application Development

on AS ABAP » ABAP Workbench - Classic » ABAP Workbench Tools » ABAP Web Services » Configuring

Web Services in SOA Manager » Configuring Service Providers and Consumers  Configuring Integration

Scenarios 3.

i Note

As of NetWeaver 740 basis, SOA Manager terminology has been partially changed:

* The term "integration scenario configuration" replaces "central business scenario configuration".
* The term "ldentifiable Business Context (IBC) reference" replaces "actors" (consumer system or
provider system).

In addition, you can use the new connection type "Service Group Based, Request Response" to directly
maintain a two-way connection: for both IBC references (actors) you can specify a service group to define
both communication directions in one step.

5.1.10.1.1 Transfer Your Business Partners

Procedure

1. Logon toyour central system.

2. Run transaction SOAMANAGER (SOA Manager) and choose ||p Service Administration ¥ Integration Scenario
Configuration 3.
3. Choose Create.

4. Inthe pop-up window, enter a name and a description (for example, <01_ERP_TM BP_TRANSFER>), and
select Create.
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5. Inthe Service Group Connections section, choose Create.

6. Inthe Assign IBC References screen, drag and drop from the Client list the ERP system reference as Actor 1.

Alternatively, use the input help to retrieve this entry.

In the Assign IBC References screen, drag and drop from the Client list the TM system reference as Actor 2.
Alternatively, use the input help to retrieve this entry.

Choose Next.

9. Inthe Connection Type field, choose Service Group Based, Request Response.

10.

11.

12.
13.

14.

15.
16.

17.

18.

In the Assign Service Groups section, choose service group MDG_BS_SUPPLI ERREPLI CATEREQfor Actor 1
and MDG_BS_SUPPLI| ERREPLI CATECONF for Actor 2.

Choose Next.
Choose Finish.

Optionally, you can choose the Check and Ping pushbuttons in the Service Group Connections section to
ensure the configuration has been correctly performed.

Choose Logon Data Assignments in the Service Group Connections section and for each interface listed,
enter under Logon Data Name the user you created in the step Create RFC Users in ERP and TM [page 13].

In the scenario configuration header, choose Check.
In the scenario configuration header, choose Ping.
In the scenario configuration header, choose Activate.

In the scenario configuration header, choose Release.

5.1.10.1.2 Transfer Your Locations

Procedure

Log on to your central system.
Run transaction SOAMANAGER (SOA Manager) and choose | Service Administration ¥ Integration Scenario
Configuration 3.

Choose Create.

4. Inthe pop-up window, assign a name and a description (for example,

<02_ERP_TM LOCATI ON_TRANSFER>), and choose Create.

5. Inthe Service Group Connections section, choose Create.

6. Inthe Assign IBC References screen, drag and drop from the Client list the ERP system reference as Actor 1.

10.

26

Alternatively, use the input help to retrieve this entry.

In the Assign IBC References screen, drag and drop from the Client list the TM system reference as Actor 2.
Alternatively, use the input help to retrieve this entry.

Choose Next.
In the Connection Type field, choose Service Group Based, Request Response.

In the Assign Service Groups section, choose service group LOCATI ON_REPLI CATE_REQfor Actor 1 and/
SCMVB/ LOC_REPLI CATE_CNF for Actor 2.
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11. Choose Next.
12. Choose Finish.

13. Optionally, you can choose the Check and Ping pushbuttons in the Service Group Connections section to
ensure the configuration has been correctly performed.

14. Choose Logon Data Assignments in the Service Group Connections section and for each interface listed,
enter under Logon Data Name the user you created in the step Create RFC Users in ERP and TM [page 13].

15. In the scenario configuration header, choose Check.
16. In the scenario configuration header, choose Ping.
17. In the scenario configuration header, choose Activate.

18. In the scenario configuration header, choose Release.

5.1.10.2 Start the Change Processor

The change processor is used in the central system to control the central configuration process. Once the
required information is maintained by the technical and business administrator in the central system, an
administrator can start the change processor.

Procedure

1. Logon to your central system.

2. Run transaction SOAMANAGER (SOA Manager) and choose | Service Administration ¥ Change Processor 4.
3. Select Release and All.

5.1.11 Technical Configuration for ALE/IDoc

You use this process to set up the distribution of material master data from your ERP system to your TM
system using the Data Replication Framework (DRF). In order to transfer materials, you need to make settings
for Application Link Enabling (ALE)/IDoc.

For more information, see SAP Note 27691864, the FAQ section, 9a.

Master data distribution is always from the ERP system to the TM system, or from a master data governance
(MDG) system to the TM system. In the IDoc settings, the sender system is always ERP and the receiver
systemis always TM.

As a prerequisite, you have configured the system connection and global settings as described in the previous
chapters. RFC destinations and logical systems exist both in TM and in ERP.
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i Note

Some settings described in this chapter, such as the creation of reduced message types with transaction
BD53, require a workbench request. You must therefore clarify with your system administrator which ERP
system and client is appropriate to carry out these steps.

i Note

The process explained in the sections below in regards to material master data transfer settings contains
only an example for the ALE/IDoc setup. ALE offers many more settings and possibilities. To familiarize
yourself with ALE in general, you can refer to the IDoc Interface/ALE pages on the SAP Help Portal.

5.1.11.1 Create Port for IDoc Processing in Sender System

You use this procedure to create a port for the receiver system in the sender system.

Procedure

In your ERP system, call transaction WE21 (Ports in IDoc Processing).
Select the port type Transactional RFC and select Create.

Choose Own Port Name and enter a port name for the TM client, for example TMLCLNTO001.

AW

On the next screen, enter the RFC Destination, for example TMLCLNTOO01 and select the processing option
Use SAP Release of Receiving System in Control Record.

5. Save the entry. You will be prompted to enter a transport request for the new message type.

5.1.11.2 Creating Reduced Message Types

You use this procedure to select segments and fields of the basic types for master data that you want to
distribute. By reducing the number of segments and fields, you also reduce the number of Customizing tables
(containing allowed field values for master data) that need to be synchronized between both systems.

Basic types for master data are supplied in the standard SAP system. If you want to reduce the basic types, you
use transaction BD53 to select the segments and fields that you want to distribute. To do this you activate the
segments and fields that you require and generate a new message type. Mandatory segments and mandatory
fields cannot be deactivated.

i Note

If you change a reduced message type after you have set up filters, some entries may be reset. In this case,
you will receive a warning in transaction BD53. You should then test the transfer again. For example, you
must check new entries in transaction BD59 as they may be removed in case of changes of an existing
reduced message type.
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5.1.11.2.1 Create a Reduced Message Type for MATMAS

You use this procedure to create a reduced message type based on the basis message type MATMAS for the
distribution of material master data to the TM system.

Context

i Note

The list of segments mentioned below is just a proposal. The list of segments and fields within them may
differ depending on the release for which you want to create the reduced message type. If you add a new
field, check whether allowed values for this field are defined in a Customizing table. If this is indeed the
case, entries for the table are also needed in your TM system.

Procedure

In your ERP system, call transaction BD53 (/Doc Reduction Maintenance).
Enter a name for the reduced message type, for example ZMATMAS and select Create.

Enter MATMAS as message type reference and select Continue.

AW oo

Enter a description for the reduced message type, for example Reduced MATMAS (Material) for TM
and select Continue.

5. Onthe next screen, select the following segments:
a. E1LMARAM(already selected as it is mandatory)
b. E1NMVARAL
c. E1MAKTM(already selected as it is mandatory)
d. ELMARMMwith sub-segment E1MEANM

6. Save your entries. You will be prompted to enter a transport request for the new message type.

5.1.11.2.2 Transport Reduced Message Types to TM

Procedure

After activation, ask your system administrator to transport the reduced message types to the TM system by
means of a transport request.
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5.1.11.3 Create Data Distribution Model

You use this procedure to define the messages in the distribution model in the sender system.

Procedure

1. Inyour ERP system, call transaction BD64 (Maintenance of Distribution Model).

2. Choose | Distribution Model » Switch Processing Mode 3.

3. To create a new model view, press Create Model View. Enter the data as shown in the following table:

Field

Value

Short Text

For example, TMLCLNT001: TM

(Replace TMLCLNTO0O1 with the logical system name for
™).

Technical Name

For example, TMLCLNTOO1

(Replace TMLCLNTOO1 with the logical system name for
™)

4. Select Continue.

5. To add message types to the model, select the new model on the list and press Add Message Type. For each
message type, enter the data as shown in the following table:

30

Field Value

Sender <ERP | ogi cal syst em», for example,
ERPCLNT001

Receiver <TM | ogi cal syst em, for example, TMLCLNTOO01

Message Type

Reduced message type for materials, for example
ZNATVAS

To create a filter group for the reduced message type for materials, for example ZMATMAS, go to the tree

and double-click No filter set or Data Filter Active under the message type ZMATMAS, then select Create

Filter Group in the dialog box.

You can, for example, filter the materials to be distributed to TM by plant. For this purpose, double-click
filter object type Plant and enter the plants that will be linked to a TM system.

You can also filter the materials by material type or material group.

i Note

Filters defined for child segments will only prevent the distribution of the child segment (ELMARMMIN
case of unit of measure filter) but not of the header segment (ELMARAM).

PUBLIC

Select Continue.
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8. Save the distribution model.

9. Choose ||» Edit » Model View ¥ Distribute Jto transport the distribution model to other systems.

5.1.11.4 Defining Partner Profiles

5.1.11.4.1 Create a Partner Profile in the Sender System
Manually

You use this procedure to create a partner profile in the sender system (ERP).

Context

You can generate the partner profile within transaction BD64 automatically or create it using transaction WE20
manually. You use this procedure to create the partner profile manually.

Procedure

1. Inyour ERP system, call transaction WE20 (Partner Profiles).

2. Select Create.

Enter the data as shown in the following table:

Field Value

Partner No. <TM | ogi cal syst em, for example, TMLCLNT001
Partner Type LS

Ty. (Post processing) US (User)

Agent RFC User

Language EN

3. Save the profile.

4. Add a new line to create outbound parameters for message type MATMAS.

i Note

The following values are examples. In terms of performance and productive reasons you may use
different values. For more information see the IDoc documentation about performance.

Enter the data as shown in the following table:
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Field Value

Message Type MATMAS

Receiver Port <TM port >, for example, TMLCLNT001

Output Mode Pass IDoc Immediately

Basic Type Use value help and select the last entry from the list, for

example MVATVAS05

Package Size 100

Cancel Processing After Syntax Error X

5. Save your data.

6. Repeat steps 4 and 5 for the reduced message type for materials, for example ZMATMVAS.

5.1.11.4.2 Create a Partner Profile in the Receiver System
Manually

You use this procedure to create a partner profile in the receiver system (TM).

Procedure

1. Inyour TM system, call transaction WE20 (Partner Profiles).
2. SelectCreate.

Enter the data as shown in the following table:

Field Value

Partner No. <ERP | ogi cal systenp, for example,
ERPCLNT001

Partner Type LS

Ty. (Post processing) US (User)

Agent RFC User

Language EN

3. Save the profile.

4. Add anew line to create inbound parameters for message type MATVAS.
Enter the data as shown in the following table:

Field Value

Message Type MATMAS
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Field Value

Process Code MATM
Cancel Processing After Syntax Error X
Trigger Immediately X

5. Save your data.

5.1.11.5 Activating Change Pointers in Sender System

Change pointers are used for logging changes of master data. Change pointers must be activated in the system

to be used. The loggings can be used for created IDoc for a delta transfer.

5.1.11.5.1 Activate Change Pointers at Client Level

You use this procedure to activate change pointers at client level.

Procedure

1. Inyour ERP system, go to Customizing for SAP NetWeaver and choose | Application Server # IDoc
Interface / Application Link Enabling (ALE) » Modelling and Implementing Business Processes » Master
Data Distribution * Replication of Modified Data j» Activate Change Pointers - Generally 3.

i Note

If your SAP system is an SAP S/4HANA system, the Customizing path is Customizing for ABAP
Platform, then choose |+ Application Server » IDoc Interface / Application Link Enabling (ALE)

» Modelling and Implementing Business Processes » Master Data Distribution » Replication of Modified
Data j» Activate Change Pointer (General) 3.

2. Select the checkbox to activate change pointers at client level.
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5.1.11.5.2 Activate Change Pointers per Message Type

You use this procedure to activate change pointers for all message types assigned to your distribution model.
The change pointers are needed to log changes to the master data and distribute them to the receiver system.

Procedure

1. Inyour ERP system, call transaction BD53 (/Doc Reduction Maintenance).
2. Enter the reduced message type for materials, for example ZMATNVAS.

3. Select Activate Change Pointers.

5.2 Data Replication from ERP to TM

Prior to replicating master data from ERP to TM, it is a mandatory prerequisite that customer/vendor
integration (CVI) has been performed in the ERP system and that business partners are available for transfer.

For additional information, see SAP Note 2713963 # .

Further information about master data replication is available at Master Data Replication in the Product
Assistance for SAP S/4HANA on the SAP Help Portal under |» Enterprise Business Applications  Supply Chain
» Delivery and Transportation » Transportation Management (TM) » Integration » Master Data Replication 3:

* Data Replication Framework
* | Data Replication Framework j Business Partner 4
* | Data Replication Framework ¥ Product J

e | Data Replication Framework ¥ Location

Further information about DRF is available at Data Replication Framework in the Product Assistance for SAP
S/4HANA on the SAP Help Portal under Cross Components.

If you are using Master Data Governance (MDG), you can find futher information about configuring data
replication at Data Replication in the Product Assistance for SAP S/4HANA on the SAP Help Portal

under | Cross Components » Master Data Governance » How to Get Master Data Governance Running

» Configuration of MDG, Central Governance j» Configuring Master Data Governance for Custom Objects » Data

Replication 3
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5.2.1 Define Technical Settings for Data Replication in ERP

Define the technical settings for data replication to configure pooled or direct replication of the business
objects that you want to replicate to your TM system.

Context

You can specify whether the system is to replicate a business object change immediately or create a change
pointer when a business object is changed. In the latter case, you need to replicate the business object
manually using transaction DRFOUT.

i Note

For more information on transferring plants or shipping points from your ERP system, please see SAP Note
2638834#% , Location Replication Out of ERP.

Procedure

1. Logon toyour ERP system.

2. Run transaction DRFI MGand choose |# Data Replication » Define Custom Settings for Data Replication
» Define Technical Settings # Define Technical Settings for Business Systems .
3. Choose New Entries and perform the following steps:

a. Enter aname for the business system that is to represent your TM system (for example, <TM SYSTEM
| D>_<CLI ENT>).
b. Select the logical system of your TM system.
c. Select the RFC destination of your TM system.
d. Save your entries.
4. Select the row containing your business system and choose Define Bus. Systems, BOs in the dialog
structure.

5. Create new entries for the following business object types:

Business Object Type Description

194 Material

986 Business Partner including Relationships
DRF_0045 Shipping Point/Receiving Point

6. (Only required if your ERP system is an SAP S/4HANA system)

As output mode, select:
* Direct Output if you want the message (IDoc) to be sent immediately.
* Pooled Output if you want to collect the messages and trigger the replication later manually.
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* Object-Dependent Default if you want to use the default setting, which is direct output for all business
objects except materials and pooled output for materials.

7. Select the row containing business object 194 and choose Define Bus. Systems, BOs, Communication
Channel in the dialog structure.

8. Create new entries for the following channels:

Channel Key Harm.

2 Replication via IDoc Not Defined

9. Select the row containing business object 986 and choose Define Bus. Systems, BOs, Communication
Channel in the dialog structure.

10. Create new entries for the following channels:

Channel Key Harm.

1 Replication via Services Not Defined

11. Select the row containing business object DRF_0045 and choose Define Bus. Systems, BOs,
Communication Channel in the dialog structure.

12. Create new entries for the following channels:

Channel Key Harm.

1 Replication via Services Not Defined

13. Save your entries.

5.2.2 Define Technical Settings for Data Replication in TM
Define the technical settings for data replication to configure pooled or direct replication of the business
objects that you want to replicate to your TM system.

Context

You can specify whether the system is to replicate a business object change immediately or create a change
pointer when a business object is changed. In the latter case, you need to replicate the business object
manually using transaction DRFOUT.

Procedure

1. Logontoyour TM system.

2. Run transaction DRFI MGand choose ||p Data Replication  Define Custom Settings for Data Replication
» Define Technical Settings » Define Technical Settings for Business Systems .
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3. Choose New Entries and perform the following steps:

a. Enter aname for the business system that is to represent your ERP system (for example, <ERP
SYSTEM | D>_<CLI ENT>).
b. Select the logical system of your ERP system.
c. Select the RFC destination of your ERP system.
d. Save your entries.
4. Select the row containing your business system and choose Define Bus. Systems, BOs in the dialog
structure.

5. Create new entries for the following business object types:

Business Object Type Description

189 Location

194 Product

986 Business Partner including Relationships

6. As output mode, select:

¢ Direct Output if you want the message (IDoc) to be sent immediately.
* Pooled Output if you want to collect the messages and trigger the replication later manually.

* Object-Dependent Default if you want to use the default setting, which is direct output for all
business objects except materials and pooled output for materials and pooled output for materials
(recommended).

7. Select the row containing business object 194 and choose Define Bus. Systems, BOs, Communication
Channel in the dialog structure.

8. Create new entries for the following channels:

Channel Key Harm.

2 Replication via IDoc 1 Harmonized IDs (no Key Mapping)

9. Select the row containing business object 986 and choose Define Bus. Systems, BOs, Communication
Channel in the dialog structure.

10. Create new entries for the following channels:

Channel Key Harm.

1 Replication via Services 2 Key Mapping

11. Select the row containing business object 189 and choose Define Bus. Systems, BOs, Communication
Channel in the dialog structure.

12. Create new entries for the following channels:

Channel Key Harm.

1 Replication via Services 2 Key Mapping

13. Save your entries.
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5.2.3 Create and Activate Replication Models (ERP to TM)

Create and activate a replication model for every business object that you want to replicate from your ERP
system to your TM system.

Context

It's good practice to create a separate replication model for every business object. From ERP to TM, you
may want to replicate materials, business partners, and locations. Alternatively, you can create one replication

model containing all the relevant business objects.

Procedure
1. Logon toyour ERP system.
2.

Run transaction DRFI MGand choose |# Data Replication » Define Custom Settings for Data Replication

» Define Replication Models .

Choose New Entries.

4. Create areplication model for every business object you want to replicate.

38

Make the following settings for your replication models:

Target System
Business Ob- for Outbound  Outbound Pa-
ject of Repli-  Outbound Im- Communica- Implementa-  rameter and Outbound Pa-
cation Model  plementation tion Channel  Filter Time tion Value rameter Value
Materials 1941 2 Replication 2 Filter After Enter the busi- PACK_SIZE_B 1000
via IDoc Change Analy- ness system ULK
sis that you cre-
) . ) ated for your
Plant Location 464_L 1 Replication 2 Filter After TM system PACK_SIZE_B 10
via Services Qhange Analy- (see Define ULK
SIS Technical Set-
Business Part-  986_3 1 Replication 2 Filter After tings for Data ~ PACK_SIZE_B 10
ner via Services Change Analy- Replicationin  yLK
sis ERP [page 35])
Shipping Point  DRF_0045_L  1Replication 2 Filter After PACK_SIZE_.B 10
Location via Services Change Analy- ULK
sis
i Note

Enter the data by navigating to the relevant folder in the dialog structure on the left-hand side of the

screen.
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5. Save your entries.
6. Return to the Define Replication Model folder in the dialog structure.

7. Select and activate your replication models.

5.2.4 Define DRF Filter Criteria

Define filter criteria for a DRF replication model to define which business object instances want to replicate to
your TM system.

Context

i Note

For more information, see Define Filter Criteria in the Product Assistance for SAP S/4HANA on the SAP

Help Portal under |+ Cross Components ¥ Data Replication Framework  Define Filter Criteria 3.

Although you can filter by IDs of individual materials, it would require you to continuously update the filter
criteria, for example, every time you create a material. This could lead to data inconsistencies due to missing
objects.

A logical approach is to filter by common attributes that every business object instance must have in your TM
system. For example, if you filter by plant, you can replicate all materials with attributes specific to this plant.

Procedure

1. Logonto your ERP system.
2. Launch transaction DRFF (Define Filter Criteria).

3. Select a DRF replication model and choose Create.

i Note

The Create button refers to filters, not replication models. If the initial screen of transaction DRFF is
empty, you haven't created a proper replication model yet. In such a case, check the steps described in
Create and Activate Replication Models (ERP to TM) [page 38].

4. Specify the filter criteria and then choose Save.
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6 Configuration of Cross-System Processes

Configure the required settings to facilitate cross-system transactional data to be exchanged when running TM
side by side your ERP system.

The ERP and TM systems exchange information concerning logistics and finances, which is often represented
by type codes, control keys, item types, organizational units, and other business configuration entities. You
need to ensure that each system is configured to support the cross-system exchange of the necessary
information.

6.1 Basic Settings for System Landscape

6.1.1 Activate Business Functions in ERP

To enable your ERP system to communicate with your TM system, you need to activate business functions.
These are individual standard applications and industry solutions in your ABAP-based SAP system. SAP
provides new features and enhancements in self-contained units via these business functions for your existing
SAP installations.

Context

Perform this step only if you're running SAP ERP 6.0 with enhancement package 7 or 8. The business functions
named here are already activated in SAP S/4HANA systems.

Procedure

1. Inyour ERP system, launch transaction SF\Wb.

2. Activate the following business functions:

Business Function Description Details
SD_01 or ESOA_OPS01 Logistics: S&D Simplification or Activate if you want to send sales
Operations, Enterprise Services orders to TM. For more information,
see SAP Note 1530240/ .
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Business Function

Description

Details

LOG ESOA OPS_2

Operations, Enterprise Services 2

Activate if you want to send purchase
orders and stock transport orders to
TM™.

OPS_ADVRETURNS_ 1

Advanced Returns Management

Activate if you want to send returns to
TM™.

LOG_TM ORD_I NT_TRQ

ERP-TMS: Basic Order Integration

You can also use this business
function to integrate order

and delivery processing in ERP

with transportation planning in

TM. It provides the same

functions as the ERP-TMS:

Order Integration (LOG_TM _ORD_I NT)
business function, but without sales
order scheduling.

LOG_ TM ORD_I NT

ERP-TMS: Order Integration

You can use this business function
to integrate order processing in

ERP with transportation planning

in TM. It enables you to optimize
order processing and transportation
planning by exchanging information
about orders and deliveries between
ERP and TM.

LOG TM ORD_I NT_I

ERP-TMS: Order and Invoice
Integration 1

Activate if you to display in ERP the
TM document status and document
flow for a specific ERP purchase
order, stock transport order, sales
order, outbound delivery, or inbound
delivery for return orders and
purchase orders.

LOG TM ORD_I NT_I |

ERP-TMS: Order Integration 2

Activate if you want to use delivery
splits or update functions, or if
you want to view the TM business
document flow and TM status
information in ERP documents.

LOG TM ORD_I NT_I I |

ERP-TMS: Order Integration 3

Activate if you want to use confirmed
quantities, shipping types or a
handover location for an external
purchase order in TM or if you want to
transfer shipment blocking reasons
to TM in order to control the blocking
of DTRs.

LOG TM ORD_I NT_I V

ERP-TMS: Order Integration 4

Activate if you want to maintain
shipment condition for PO and
interface this to TM and/or want

to use handover date for PO
confirmations and want to use this in
T™M.

LOG TM I V_I NT

TMS-ERP: Invoice Integration

You use this business function to
create, enter, process, or display
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Business Function Description Details

invoices that refer to documents in
TM. This allows you to carry out
invoice processing for the connected
TM system in ERP and use the main
ERP invoice processing functions in

MM and SD.
LOG TM SAG I NT_I Scheduling Agreement Integration Activate if you want to integrate SD
with SAP TM scheduling agreements and / or MM

scheduling agreements into TM and
create transportation requirements
for these.

If you want to use cost distribution, you also have to activate the following business functions (besides
LOG TM ORD INT_I1):

Business Function Description Details

| SR_RET_AGENCY Trade, Agency Business Activate if you want to use additional
features of Agency Business (such as
Credit Management or Configuration
and Collection Invoices) to implement
your business processes more
flexibly.

| SR_RET_AGENCY2 Trade, Agency Business 2 Activate if you want to use
additional functions in the Agency
Business area. You can create
extended remuneration lists from
FI documents, differing partner
roles, payment documents without
business partners in agency
documents, and agency documents
without tax codes. New reports are
also available for mass processing.

| SR_RET_ACENCY3 Trade, Agency Business 3 Activate if you want to implement the
following new or extended business
processes:
* Extended Complaints Processing

® Clearing Processing

For more information about business functions, please see Prerequisites: Invoice Processing (MM-IV/
SD-BIL) - SAP TM and Prerequisites for Order and Delivery Integration in the Product Assistance for

SAP S/4HANA on the SAP Help Portal under |+ Product Assistance ¥ Enterprise Business Applications
» Supply Chain ¥ Logistics Cross Topics ¥ Logistics - General (LO) ¥ Integration with SAP Transportation
Management 3.
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6.1.2 Application Configuration for SOA Manager

1. Create one integration scenario configuration for each integration scenario. For more information, see
Integration Scenario Configuration [page 25].

2. Create and assign logon data. You only need to do this once for each managed system. For more
information, see Create and Assign Logon Data in Your Central System [page 23].

3. Start the change processor. For more information, see Start the Change Processor [page 27].

4. Create logical receiver determinations in SOA Manager (optional).
You should create logical receiver determinations for a service group if the service group contains a logical
receiver determination structure (LRD filter).

The local SOA Manager can be called directly out of the central system using | Central System
» Connections ¥ Open local SOAMANAGER 3.

O\ Caution

The following LRD filters have to be used for the service groups to enable the services. If the LRD filter
for a service group is not set, none of the contained services will be executed.

Scenario Service Group LRD Filter Fields of LRD Filter
Location Integration LOCATI ON_REPLI CATE_RE LRD_SLD BSKEY BSKEY
Q

6.1.2.1 Integration Scenario Configuration

In a system landscape, one ABAP system can be defined as the central system. From this central system, entire
integration scenarios can be configured and the configurations can be distributed to all affected systems that
take part in the central configuration.

For more information on configuring integration scenarios, see Configuring Integration Scenarios in the

SAP Library for SAP NetWeaver on the SAP Help Portal under |+ Application Help  SAP NetWeaver

Library: Function-Oriented View ¥ Application Server  Application Server ABAP ¥ Application Development

on AS ABAP » ABAP Workbench - Classic  ABAP Workbench Tools » ABAP Web Services » Configuring

Web Services in SOA Manager » Configuring Service Providers and Consumers  Configuring Integration

Scenarios .

i Note
As of NetWeaver 740 basis, SOA Manager terminology has been partially changed:

* The term "integration scenario configuration" replaces "central business scenario configuration".

* The term "ldentifiable Business Context (IBC) reference" replaces "actors" (consumer system or
provider system).
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In addition, you can use the new connection type "Service Group Based, Request Response" to directly
maintain a two-way connection: for both IBC references (actors) you can specify a service group to define
both communication directions in one step.

6.1.2.1.1 Perform Order and Delivery Integration

Procedure
1. Log on to your central system.
2. Run transaction SOAMANAGER and choose ||» Service Administration ¥ Integration Scenario Configuration 3.
3. Choose Create.
4. Inthe pop-up window, assign a name and a description (for example,
<03_ERP_TM LOGQ STI CS_| NTEGRATI ON>), and choose Create.
5. Inthe Service Group Connections section, choose Create.

6. Inthe Assign IBC References screen, drag and drop from the Client list the ERP system reference as Actor 1.
Alternatively, use the input help to retrieve this entry.

7. Inthe Assign IBC References screen, drag and drop from the Client list the TM system reference as Actor 2.
Alternatively, use the input help to retrieve this entry.

8. Choose Next.

9. Inthe Assign Service Groups screen, in the Connection Type field, select Service Group Based, Request
Response.

10. Select service group TM_ERP_ORDI NT for Actor 1 and / SCMTMS/ TM_ERP_CRDI NT for Actor 2.
11. Choose Next.
12. Choose Finish.

13. Repeat steps 5 to 12, using service group TM_ERP_ORDI NT_ENH for Actor 1 and / SCMI\Ms/
TM ERP_DELI VERY_SPLI T for Actor 2.

14. Repeat steps 5 to 12, using connection type Service Group Based, One Way and service group
TM_ERP_ORDI NT_BDFLWfor Actor 1.

15. Repeat steps 5 to 12, using connection type Service Group Based, One Way and service group
TM _ERP_CORDI NT_SE for Actor 1.

16. Optionally, you can choose the Check and Ping pushbuttons in the Service Group Connections section to
ensure the configuration has been correctly performed.

17. Choose Logon Data Assignments and for each interface listed, maintain under Logon Data Name the user
created in Create RFC Users in ERP and TM [page 13].

18. Choose Check on the scenario configuration header.
19. Choose Ping on the scenario configuration header.
20.Choose Activate on the scenario configuration header.

21. Choose Release on the scenario configuration header.
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61212 Perform Invoice Integration

Procedure

—
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10.
11.
12.
13.

14.

15.
16.

17.

18.

Log on to your central system.

Run transaction SOAMANAGER and choose ||» Service Administration ¥ Integration Scenario Configuration 4.
Choose Create.

In the pop-up window, assign a name and a description (for example,
<04_ERP_TM I NVO CE_I NTEGRATI ON>), and choose Create.

In the Service Group Connections section, choose Create.

In the Assign IBC References screen, drag and drop from the Client list the ERP system reference as Actor 1.
Alternatively, use the input help to retrieve this entry.

In the Assign IBC References screen, drag and drop from the Client list the TM system reference as Actor 2.
Alternatively, use the input help to retrieve this entry.

Choose Next.

In the Assign Service Groups screen, in the Connection Type field, select Service Group Based, Request
Response.

Select service group TM_ERP_I NVI NT for Actor 1 and / SCMIMS/ TM_ERP_I NVI NT for Actor 2.
Choose Next.
Choose Finish.

Optionally, you can choose the Check and Ping pushbuttons in the Service Group Connections section to
ensure the configuration has been correctly performed.

Choose Logon Data Assignments and for each interface listed, maintain under Logon Data Name the user
created in Create RFC Users in ERP and TM [page 13].

Choose Check on the scenario configuration header.
Choose Ping on the scenario configuration header.
Choose Activate on the scenario configuration header.

Choose Release on the scenario configuration header.

TM Integration Guide for DSC Edition
Configuration of Cross-System Processes PUBLIC 45



6.2 Customizing Settings for your ERP and TM Systems

Prerequisites

You have set up the system landscape. This includes the following steps:

You have set up the connection to the System Landscape Directory (SLD) for all systems.

You have configured the settings that are required to connect a business system to SOA Manager.

You have configured the settings that are required to use the Data Replication Framework (DRF) for master
data transfer.

You have set up a trusted connection between the ERP and TM systems.

You have defined all required RFC users, RFC connections, logical system names, technical system names,
and business system names.

You have set up the required workflows.

More Information

For more information, including information on configuring integration of orders and deliveries, and on the
integration of ERP orders and deliveries in transportation planning, see External TM System Integration in

the Product Assistance for SAP S/4HANA on the SAP Help Portal under | Enterprise Business Applications
» Supply Chain ¥ Delivery and Transportation ¥ Transportation Management (TM) # Logistics Integration

» External TM System Integration .

6.2.1 Create a TM Release

Procedure

46

In your ERP system, in Customizing for Integration with Other SAP Components, choose | Advanced
Planning and Optimization ¥ Basic Settings for Setting Up the System Landscape ¥ Specify SAP APO
Release (transaction NDV2) 1.

Enter the data as shown in the table below.
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Field Sample Entry

Logical System <SSS>CLNT<CCC>

- Recommendation

We recommend that a logical system adheres to the
naming convention <SSS>CLNT<CCC>, where SSS is
the 3-character system ID and CCC is the client.

System Type SAP_S4HANA

Release 105 for example

3. Save your entries.

6.2.2 Create ISO Units in ERP

Procedure

1. Inyour ERP system, in Customizing for SAP NetWeaver, choose |# General Settings ¥ Check Units of
Measurement 3.

i Note

If your ERP system is an SAP S/4HANA system, the Customizing path is Customizing for [+ ABAP
Platform ¥ General Settings » Check Units of Measurement 3.

2. Choose ISO codes and then New Entries.

3. Create a new ISO code with the following data:

Field Value

ISO code E22

ISO code text 20- Foot Cont ai ner
i Note

You must create ISO units in the same way in both ERP and TM. Otherwise, problems will arise when
messages are exchanged between these systems.
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6.2.3 Create ISO Unitsin TM

Procedure

1. Inyour TM system, in Customizing for ABAP Platform, choose ¢ General Settings ¥ Check Units of
Measurement 3.
2. Choose ISO codes and then New Entries.

3. Create a new ISO code with the following data:

Field Value

ISO code E22

ISO code text 20- Foot Cont ai ner
i Note

You must create ISO units in the same way in both ERP and TM. Otherwise, problems will arise when
messages are exchanged between these systems.

6.2.4 Create Units of Measurement in ERP

Procedure

1. Inyour ERP system, in Customizing for SAP NetWeaver, choose |» General Settings » Check Units of

Measurement .

i Note

If your ERP system is an SAP S/4HANA system, the Customizing path is Customizing for [ ABAP
Platform ¥ General Settings » Check Units of Measurement 3.

2. Select (no di mensi ons) and then Units of Measurement.

3. Create a new unit of measurement as follows:

Field Value

Int. meas. unit TEU
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Field Value

Display screen area and Unit of Measurement Text screen area

Commercial TEU 20- Foot Cont ai ner
Technical TEU 20-Ft Cont

Decimal places Leave this field empty

Exp. 10 Floating Pt Leave this field empty

ALE/EDI screen area

ISO code E22

Primary code Select this checkbox

Conversion screen area

Decimal pl. rounding Leave this field empty

Unit of meas. family Leave this field empty

Application Parameters screen area

Commercial meas. unit Select this checkbox
Value-based commt Do not select this checkbox
i Note

You must create ISO units in the same way in both ERP and TM. Otherwise, problems will arise when
messages are exchanged between these systems.

6.2.5 Change Units of Measurement in ERP

Procedure
1. Inyour ERP system, in Customizing for SAP NetWeaver, choose |# General Settings ¥ Check Units of
Measurement 3.
i Note

If your ERP system is an SAP S/4HANA system, the Customizing path is Customizing for [» ABAP
Platform » General Settings » Check Units of Measurement 3.
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In the dropdown box, select Mass and choose Units of measurement.
Select the LB unit and assign the ISO code LBR.

Select the KGunit and assign the ISO code KGV

Return to the initial screen.

In the dropdown box, select Volume and choose Units of measurement.
Select the FT3 unit and assign the ISO code FTQ

Select the MB unit and assign the ISO code MIQ.

i Note

You must create ISO units in the same way in both ERP and TM. Otherwise, problems will arise when
messages are exchanged between these systems.

6.2.6 Change Units of Measurement in TM

Procedure

© N O oA W N
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In your TM system, in Customizing for ABAP Platform, choose |+ General Settings ¥ Check Units of
Measurement 3.

In the dropdown box, select Mass and choose Units of measurement.

Select the LB unit and assign the ISO code LBR.

Select the KGunit and assign the ISO code KGM

Return to the initial screen.

In the dropdown box, select Volume and choose Units of measurement.

Select the FT3 unit and assign the ISO code FTQ

Select the MB unit and assign the ISO code MIQ.

i Note

You must create ISO units in the same way in both ERP and TM. Otherwise, problems will arise when
messages are exchanged between these systems.
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6.2.7 Configuration Settings for Invoice Integration

You use this process to configure the settings in your ERP system that enable you to integrate invoice
processing in ERP with TM.

6.2.71 User Settings for Invoice Verification Based on TM

Context

To enable a user to perform invoice verification in your ERP system, you have to assign profile parameter
TM_ | NVO CE_CLERK to the user’s profile in the ERP system.

Procedure

In the ERP system, call transaction SUO1.
Enter the user and choose Change.
Choose the Parameters tab.

In the Parameter ID column, enter TM_| N\VO CE_CLERK.

o s W e

Save your entries.

6.2.7.2 Define Default Account Assignment of Cost
Element

Procedure

1. Inyour ERP system, in Customizing for Controlling, choose |» Cost Center Accounting * Actual Postings
Manual Actual Postings ¥ Edit Automatic Account Assignment

2. Maintain one or more relevant entries for the combination of company code and account you plan to use as
part of your processes.

TM Integration Guide for DSC Edition
Configuration of Cross-System Processes PUBLIC 51



6.2.7.3 Define Service Master for Invoice Integration

Procedure

1. Inyour ERP system, on the SAP Easy Access screen, choose | Logistics » Materials Management
» Service Master  Service ¥ Service Master 3.

2. Choose Create New Service and maintain one or more relevant entries that you plan to use as part of your
processes.

6.2.74 Create Event Type Linkages

Context

In this step, you activate workflow W553800006 for incoming invoices and activate event linkage for the
events POSTED and CANCELLED. The workflow triggers the | nvoi ceNot i fi cati on_Qut message when an
incoming invoice is posted or canceled. The message informs TM about the posted or canceled invoice.

i Note

For information about setting up workflows, see Automatic Workflow Customizing in the SAP Library

for SAP NetWeaver on the SAP Help Portal under |[[» SAP NetWeaver Library: Function-Oriented View

» Application Server » Application Server ABAP » Other Services ¥ Services for Application Developers
» SAP Business Workflow # Role Documentation j Roles in Workflow  System Administrator » Business

Workflow Administration » Workflow System Administration ¥ Automatic Workflow Customizing 3.

Procedure

1. Inyour ERP system, on the SAP Easy Access screen, choose |+ Tools » ABAP Workbench ¥ Development
» SAP Business Workflow  Definition Tools » Events » Event Linkages # Type Linkages 3.

2. Make the following entries and select the Type linkage active checkbox:
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Object Category Object Type Event Receiver Type Linkage Acti- Receiver Func-
vated tion Module
BOR Object BUS2081 CANCELLED WS53800006 Select this check- SWW_WI_CRE-
box ATE_VIA_EVENT_
IBF
BOR Object BUS2081 POSTED WS53800006 Select this check- SWW_WI_CRE-
box ATE_VIA_EVENT_
IBF

3. Save your entries.

4. Inyour ERP system, on the SAP Easy Access screen, choose |F Tools  ABAP Workbench ¥ Development
» SAP Business Workflow » Utilities » Automatic Workflow Customizing 3.
5. Choose Perform Automatic Workflow Customizing ([F9)).

6.2.7.5 Invoice Integration

You can transfer a freight settlement document (FSD) and a forwarding settlement document (FWSD) to your

ERP system.

6.2.7.5.1

Message Flow for Invoice Integration

The following table describes the message flow for forwarding settlement requests and customer invoices in

invoice integration:

Message

Description

Cust oner Frei ght | nvoi ceRequest SUl TERequest _Qut
Vi

Send create or change requests for forwarding settlements
from T™M

Cust oner Fr ei ght | nvoi ceRequest SUl TERequest _| n_

V1

Receive create or change requests for customer invoices in
ERP

Cust oner Fr ei ght | nvoi ceRequest SUl TEConfirmati o
n_Qut_Vi

Send confirmations for customer invoices from ERP

Cust omer Fr ei ght | nvoi ceRequest SUl TEConfi rmati o
n_In_V1

Receive confirmations for forwarding settlements in TM

Cust omer Fr ei ght | nvoi ceRequest SUl TECancel | ati o
nRequest _Qut _V1

Send cancel requests for forwarding settlements from TM
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Message

Description

Cust oner Fr ei ght | nvoi ceRequest SUl TECancel | ati o
nRequest _I n_V1

Receive cancel requests for customer invoices in ERP

Cust oner Fr ei ght | nvoi ceRequest SUI TESi nul at e_CQu
t

Send forwarding settlements from TM for invoice preview
and receive PDF of ERP billing

Cust omrer Frei ght | nvoi ceRequest SUl TESi nul ate_I n

Receive forwarding settlements from TM for invoice preview
and send PDF of ERP billing

The following table describes the message flow for freight settlement requests and supplier invoices in invoice

integration:

Message

Description

Transportati onOr der SUl TEl nvoi ci ngPreparati onR

equest _Qut

Send create or change requests for freight settlements from
™

Transportati onOr der SUl TEl nvoi ci ngPrepar ati onR

equest _In

Receive create or change requests for supplier invoices in
ERP

Transportati onOr der SUl TEl nvoi ci ngPreparati onC

onfirmation_Qut

Send confirmations for supplier invoices from ERP

Transportati onOr der SUl TEl nvoi ci ngPreparati onC

onfirmation_In

Receive confirmations for freight settlements in TM

Transportati onOr der SUl TEl nvoi ci ngPreparati onC

ancel | ati onRequest _Qut

Send cancel requests for freight settlements from TM

Transportati onO der SUl TEl nvoi ci ngPreparati onC

ancel | ati onRequest _I n

Receive cancel requests for supplier invoices in ERP

The following table describes the invoice notification messages in invoice integration:

Message

Description

I nvoi ceNoti fication_Qut

Send invoice notification from ERP

I nvoi ceNotification_In

Receive invoice notifications in TM

6.2.7.5.2 Invoicing

You can specify the relevant Customizing settings in your ERP system under | Integration with Other SAP

Components  Transportation Management @ Invoice Integration » Invoicing 3.
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To integrate freight settlement documents with service purchase order and service entry sheet documents,
you must specify the following settings:
¢ (Category codes, subcategory codes, and charge types in ERP for the charge types from TM. You can
specify the settings in the following Customizing activities under | Definition of Transportation Charge
Elements 2
* Define Category Codes
* Define Subcategory Codes
* Define Charge Types
* Role codes in ERP for the TM currency and amount. You can specify the settings in the following activities
under |+ Definition of Transportation Management Role Codes 3
* Define Role Codes (Currency)
* Define Role Codes (Amount)

You must assign the following attributes:

* Transportation charge item categories, item subcategories, and items in TM to service master data
records and account assignment categories in ERP. You can specify the settings under | Assignment
of Transportation Charge Elements # Assign Service Master Record and Account Assignment Category 3.
* Under | Mapping of Organizational Units 3, you must assign the following attributes:

* Purchasing business areas from TM to the organizational units in purchasing in ERP in the Assign
Organizational Units for Purchasing activity

* Purchasing organization unit in TM to an internal order and cost center account in ERP in the Assign
TM Purchase Org. Unit to Internal Order/Cost Center activity

6.2.7.5.2.1 Define Category Codes for Invoice Integration

Procedure

1. Inyour ERP system, in Customizing for Integration with Other SAP Components , choose | Transportation
Management » Invoice Integration ¥ Invoicing ¥ Definition for Transportation Charge Elements » Define
Category Codes. J

2. Maintain one or more relevant entries that you plan to use as part of your processes.
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6.2.7.5.2.2 Define Subcategory Codes for Invoice Integration

Procedure

1. Inyour ERP system, in Customizing for Integration with Other SAP Components, choose |[» Transportation
Management » Invoice Integration j» Invoicing » Definition for Transportation Charge Elements » Define
Subcategory Codes.

2. Maintain one or more relevant entries that you plan to use as part of your processes.

6.2.7.5.2.3 Define Charge Types for Invoice Integration

Procedure

1. Inyour ERP system, in Customizing for Integration with Other SAP Components, choose | Transportation
Management » Invoice Integration ¥ Invoicing » Definition for Transportation Charge Elements » Define
Charge Types

2. Maintain one or more relevant entries that you plan to use as part of your processes.

6.2.7.5.2.4 Assign Service Master to Transportation Charge
Elements

Procedure

1. Inyour ERP system, in Customizing for Integration with Other SAP Components, choose ||» Transportation
Management » Invoice Integration ¥ Invoicing » Assignment of Transportation Charge Elements » Assign
Service Master Record and Account Assignment Category.

2. Ensure that the entries created as part of Define Charge Types for Invoice Integration [page 56] and Define
Service Master for Invoice Integration [page 52] are mapped accordingly in this activity.
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6.2.7.5.3 Cost Distribution

Cost Distribution for Shippers

You create a freight settlement document to transfer the transportation costs from TM to your ERP system for
verification. You must perform cost distribution at the level of ERP item in the freight settlement document. You
use service entry sheets and agency business documents to post the distributed costs in ERP.

To integrate cost distribution in freight orders and freight settlement documents with your ERP system, you
must assign the transportation charge type in TM to a condition type in ERP for cost distribution. You can do
this in Customizing for Integration with Other SAP Components under | Transportation Management # Invoice

Integration » Mapping for Cost Distribution ¥ Assign Transportation Charge Elements to Condition Types 4.

To use agency business documents to post distributed costs in your ERP system, you must specify the
following settings in the following Customizing activities, which you can find under || Integration with

Other SAP Components ¥ Transportation Management j# Invoice Integration » Mapping for Cost Distribution
» Mapping for Cost Distribution ¥ Posting via Agency Business 3:

* Application type and posting types in Define Application and Posting Type.
* Dataused in agency business document creation in Basic Settings for Creation of Agency Documents.

6.2.7.5.4 Integration Business Add-Ins

You can access the following Business Add-Ins (BAdIs) on the SAP Easy Access screen under |+ Tools » ABAP
Workbench @ Utilities » Business Add-Ins ¥ Definition 3:

* BAdI: FSD Invoicing Preparation: Data Modify (TCM_SE_TORI NVPREPREQ PRCC)
* BAdI: Inbound/Outbound Processing for FSD Invoicing Preparation (TCM_SE_TORI NVPREPREQ ASYN)

* BAdI: Inbound/Outbound Processing for FSD Invoicing Cancellation CNC
(TCM_SE_TORI NVPREPCNCLN_ASYN)

* BAdI: Creation of SD Billing Document (TCM_SE_CFI RSUl TE_RQ)
* BAdI: Cancellation of SD Billing Document (TCM_SE_CFI RSUI TE_CNCLNRQ)

You can access the BAdI implementation Activate BAdl Implementation for Invoice Verification Correction
Postings (WZRE_TNMS_I V) in Customizing for Integration with Other SAP Components under |# Transportation
Management * Invoice Integration » Mapping for Cost Distribution j» Activate BAdI Implementation for Invoice

Verification Correction Postings 4. If you have a charge correction, the ERP system updates the agency
business document during invoice verification. If you want to use this feature in your ERP system, you must
activate this BAdI.
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6.2.8 Configuration Settings for Order and Delivery
Integration

You use this process to configure the settings in your ERP system that enable you to integrate order and
delivery processing in ERP with TM.

6.2.8.1 Define Control Keys for Document Transfer

In this procedure, you define the control keys that determine which documents or document chains are to be
transferred to TM. You can define as many control keys as required with different combinations of documents.
For sales orders, you can also specify whether sales order scheduling is to take place in TM.

Procedure

1. Inyour ERP system, in Customizing for Integration with Other SAP Components, choose | Transportation
Management j» Order Integration j» Define Control Keys for Document Transfer

2. Make sure that one or more control keys are maintained that cover one or more combinations of
documents to be transferred to TM. You use the control keys in the configuration steps to activate
document transfer to TM.

If you require additional control keys, you can create them in this Customizing activity.

6.2.8.2 Maintain Output Determination for Sales
Documents

The following settings must be configured to send sales documents from ERP to TM. Output determination is
used to create XML messages, which are then sent to TM.
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6.2.8.2.1 Maintain Condition Tables (SD)

In this step, you define the combination of fields for which you want to create output condition records in a
condition table. This enables you to control output determination depending on your specific field combination.
Alternatively, you can check whether the data you need is already available.

Context

You need to check whether the required fields are assigned to the condition table.

Procedure

1. Inyour ERP system, in Customizing for Sales and Distribution, choose ||» Basic Functions » Output

Control » Output Determination ¥ Output Determination Using the Condition Technique » Maintain Output

Determination for Sales Documents ¥ Maintain Condition Tables .

2. Choose Maintain Output Condition Table for Sales Documents.

3. Ensure that the Sales Document Type field is assigned to condition table 007 Order Type.

If this is not the case, create a new condition table for output control, as follows:

a.

In Customizing for Sales and Distribution, choose | Basic Functions » Output Control

» Output Determination » Output Determination Using the Condition Technique  Maintain Output
Determination for Sales Documents ¥ Maintain Condition Tables .

Choose Maintain Output Condition Table for Sales Documents.

Choose | Condition # Create 3.

In the Table field, enter a name (3-digit number) for the new condition table that is to be created. Note
that you can only choose names between 900 and 999.

Choose Enter.

Enter a description for the new condition table, for example, Or der Type.

Select the required fields for the condition table from the list of allowed fields, for example, Sales
Document Type .

Generate the new condition table.

You have defined a new condition table for which you can maintain condition records.
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6.2.8.2.2 Maintain Output Types (SD)

Procedure

1. Inyour ERP system, in Customizing for Sales and Distribution, choose | Basic Functions ¥ Output
Control » Output Determination ¥ Output Determination Using the Condition Technique ¥ Maintain Output
Determination for Sales Documents » Maintain Output Types. 4

2. Make sure that output types TRSO (order to external TMS) and TRRO (returns to external TMS) have been

entered.
3. Select output type TRSO and choose Details.

4. Enter the following data on the General data tab:

Field

Value

Access Sequence

0002

Access to Conditions

Select this checkbox

Multiple Issuing

Select this checkbox

Partner-Indep. Output

Select this checkbox

Program

OPS_SE_SOC_SEND_MESSAGE

FORM Routine

CHECK_REPEAT

5. Enter the following data on the Default values tab page:

Field

Value

Dispatch Time

Send | nmedi ately (when saving the
appl i cation)

Transmission Medium

8 Special function

6. Repeat steps 3 to 6 for output type TRRO.
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6.2.8.2.3 Maintain Access Sequences (SD)

Prerequisites

You have already defined the necessary condition tables.

Context

In this step, you can check whether the required access sequences are available, or you can create access
sequences that you can use to determine the following:

¢ Which condition tables are used to access condition records

¢ The sequence of these condition tables

¢ With which field contents they are read

Procedure

1. Inyour ERP system, in Customizing for Sales and Distribution, choose | Basic Functions ¥ Output
Control » Output Determination  Output Determination Using the Condition Technique » Maintain Output
Determination for Sales Documents ¥ Maintain Access Sequences 4.

2. Inthe overview area, select access sequence 0002 Order Type.

3. Choose Accesses.
Condition table 7 is displayed in the Overview Accesses table.
If the right access sequence is not available, create it as follows:

a. Inyour ERP system, in Customizing for Sales and Distribution, choose | Basic Functions  Output
Control » Output Determination » Output Determination Using the Condition Technique » Maintain
Output Determination for Sales Documents ¥ Maintain Access Sequences 4.

b. Inchange mode, choose New Entries.

c. InAccess Sequences, create an access sequence by defining an alphanumeric key (with a maximum of
four characters) and enter a description.

d. InSource, select one of the following sources: Other system (for example, ERP) or Local.

e. Selectarow inthe Access Sequences table, and in the left frame, choose Fields.

You can define the accesses by defining the sequence of accesses in the access sequence and
choosing the corresponding condition tables.

f. Choose Save.

TM Integration Guide for DSC Edition
Configuration of Cross-System Processes PUBLIC 61



6.2.8.2.4 Maintain Output Determination Procedure (SD)

Context

Procedure

1. Inyour ERP system, in Customizing for Sales and Distribution, choose |» Basic Functions » Output
Control » Output Determination » Output Determination Using the Condition Technique » Maintain Output
Determination for Sales Documents » Maintain Output Determination Procedure.

2. Make sure that procedure V10000 has been entered.

3. Inthe dialog structure, select Control Data.

4. Make sure that the following entries have been made for procedure V10000:

Reference Step Overview

Step Condition Counter Condition Type Requirement
<Any avail able step 1 TRSO 27
nunber >

<Any available step 1 TRRO 28
nunber >

6.2.8.2.5 Assign Output Determination Procedures (SD)

Prerequisites

You have defined the following:

* Qutput determination procedures
*  OQutput types
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Context

In this step, you assign output determination procedures to document types. You can also specify an output
type that is to be displayed when the relevant document is displayed or changed.

Procedure

1. Inyour ERP system, in Customizing for Sales and Distribution, choose ||» Basic Functions » Output
Control » Output Determination ¥ Output Determination Using the Condition Technique » Maintain Output
Determination for Sales Documents ¥ Assign Output Determination Procedure 3.

2. Choose Allocate Sales Document Header.

3. Inthe overview, assign the output determination procedures as follows:

Assignments

Sales Document Type Output Determination Procedure Output Type
OR Standard Order V10000 TRSO
i Note

It is sufficient to assign an output determination procedure (such as V10000) to a sales order type
(such as OR) in this Customizing activity. The output type may differ from that specified here, but must
be defined for the corresponding output determination procedure. As long as the relevant output type
(TRSO or TRRO) is maintained for the output determination procedure, it will be taken into account by
the system at processing time.

ORand RE are standard order types that are delivered as part of standard ERP Customizing.

6.2.8.26 Create Output Condition Records (SD)

Context

In this step, you link the order type of your sales document with an output type that is configured for the data
transfer to TM. You define the message attributes, for example, the processing time or the language. From a
technical point of view, you create condition records.
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Procedure

1. For the output type TRSO, perform the following steps:

a. Onthe SAP Easy Access screen for your ERP system, choose |# Logistics # Sales and Distribution
» Master Data » Output » Sales Document » Create J or call transaction W11.
b. Choose Output Type TRSO.

c. Choose .

d. On the following screen, enter the data as shown in the following table:

SD Type Name Medium Date/Time Language
OR Standard Order 8 Special Function 4 Send immediately EN
(when saving the
application)

e. Note the following:
Leave the Funct. and Partner fields blank.

ORis a standard order type that is delivered as part of standard ERP Customizing.
f. Save your entry.

2. For the output type TRRO, perform the following steps:

a. Onthe SAP Easy Access screen for your ERP system, choose [ Logistics ¥ Sales and Distribution
» Master Data » Output » Sales Document » Create J or call transaction W11.
b. Choose Output Type TRRO.

c. Choosel[Enter |

d. Onthe following screen, enter the data as shown in the following table:

SD Type Name Medium Date/Time Language
RE RE Returns 8 Special Function 4 Send immediately EN
(when saving the
application)

e. Note the following:
Leave the Funct. and Partner fields blank.

RE is a standard order type that is delivered as part of standard ERP Customizing.

=

Save your entry.

TM Integration Guide for DSC Edition
64 PUBLIC Configuration of Cross-System Processes



6.2.8.3 Maintain Workflow Event Type Linkages for
Purchase Orders

In this step, you maintain purchase orders and stock transport orders. In contrast to sales documents
and deliveries, which are processed using output control, purchase orders and stock transport orders are
processed using workflow technology.

Context

i Note

For information about setting up workflows, see Automatic Workflow Customizing in the SAP Library

for SAP NetWeaver on the SAP Help Portal under |+ SAP NetWeaver Library: Function-Oriented View

» Application Server » Application Server ABAP » Other Services * Services for Application Developers
» SAP Business Workflow # Role Documentation j Roles in Workflow  System Administrator » Business
Workflow Administration » Workflow System Administration ¥ Automatic Workflow Customizing 3.

Procedure

1. Onthe SAP Easy Access screen of your ERP system, choose [F Tools » ABAP Workbench ¥ Development
» SAP Business Workflow » Definition Tools j» Events » Event Linkages #» Type Linkages 3.

2. Create the following entries:

Field Value

Object Category ABAP Cl ass

Object Type CL_SE PUR PO W_OUT

Event CHANGED

Receiver Type W553800008

Receiver Call Function Modul e

Receiver Function Module SWV W CREATE_VI A EVENT | BF
Linkage Activated Selected
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Field Value

Object Category ABAP Cl ass

Object Type CL_SE PUR PO W_OUT

Event Created

Receiver Type WE53800008

Receiver Call Function Modul e

Receiver Function Module SWNV W _CREATE_VI A_EVENT _| BF
Linkage Activated Selected

3. Save your entries.

4. Onthe SAP Easy Access screen of your ERP system, choose ||# Tools » ABAP Workbench ¥ Development
» SAP Business Workflow ¥ Utilities ¥ Automatic Workflow Customizing 3.

5. Choose Perform Automatic Workflow Customizing (F9).

6.2.8.4 Maintain Output Determination for Outbound
Deliveries

You must configure the following settings to send outbound deliveries from ERP to TM. Output determination is
used to create XML messages, which are sent to TM.

6.2.8.4.1 Maintain Condition Tables (Outbound Delivery)

In this step, you define the combination of fields for which you want to create output condition records in a
condition table. This enables you to control output determination depending on your specific field combination.
Alternatively, you can check whether the data that you need is already available.

Procedure

1. Inyour ERP system, in Customizing for Logistics Execution, choose |# Shipping ¥ Basic Shipping Functions
» Output Control » Output Determination » Maintain Output Determination for Outbound Deliveries
» Maintain Condition Tables 3.

2. Choose Maintain Output Condition Table for Deliveries.
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3. Make sure that the field Delivery Type is assigned to condition table 009.
If that is not the case, create a new condition table for output control (shipments) as follows:

a. Inyour system, in Customizing for Logistics Execution, choose | Shipping ¥ Basic Shipping Functions
» Output Control » Output Determination j Maintain Output Determination for Outbound Deliveries
» Maintain Condition Tables 3.

b. Choose Maintain Output Condition Table for Deliveries.

c. Choose|r Condition ¥ Create .
d. Inthe Table field, enter a name (3-digit number) for the new condition table that is to be created. Note
that you can only choose names between 900 and 999.

e. Choose .

f. Enter a description for the new condition table, for example, Del i very Type.
g. Select the required fields for the condition table from the list of allowed fields, for example, Delivery

Type.
h. Generate the new condition table.

6.2.8.4.2 Maintain Access Sequences (Outbound Delivery)

Prerequisites

You have defined the necessary condition tables.

Context

In this procedure, you check whether the required access sequences are available or you create access
sequences that you can use to determine the following:

¢ The condition tables that are used to access condition records

¢ The sequence of these condition tables

* The field contents with which they are read

Procedure

1. Inyour ERP system, navigate to Customizing for Logistics Execution and choose | Shipping
» Basic Shipping Functions » Output Control » Output Determination » Maintain Output Determination for
Outbound Deliveries ¥ Maintain Access Sequences 3.

2. Inthe overview, choose access sequence 0001 Delivery Type.
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3. Choose Accesses.

4. The Accesses Overview area contains condition table 9.

If the correct access sequence is not available, create it as follows:

a. Inyour ERP system, navigate to Customizing for Logistics Execution and choose | Shipping # Basic
Shipping Functions # Output Control » Output Determination » Maintain Output Determination for
Outbound Deliveries » Maintain Access Sequences J.

b. Switch to change mode.

c. Choose New Entries.

d. InAccess Seq, create an access sequence by defining an alphanumeric key (with a maximum of four
characters) and enter a description.

e. InDescription, enter a description.

f. In Source, select one of the following sources: Other system (for example, ERP) or Local.

g. Select arow in the Access Sequences table, and in the left frame, choose Fields.

You can define the accesses by defining the sequence of accesses in the access sequence and
choosing the corresponding condition tables.
h. Choose Save.

In the Determine Work Area: Entry dialog box, you can enter a value directly so that the system
overwrites the value transferred from the calling application. You can also set an initial indicator.

6.2.8.4.3 Maintain Output Types (Outbound Delivery)

Procedure

1. Inyour ERP system, in Customizing for Logistics Execution, choose | Shipping ¥ Basic Shipping Functions
» Output Control ¥ Output Determination » Maintain Output Determination for Outbound Deliveries
» Maintain Output Types. 3

2. Make sure that output type TRDO (delivery to external TMS) has been entered.

If not, enter TRDO with the following data:

Output Types
Output Type TRDO
Description Cr./Chg TMInt. ODLV

General Data tab

Access sequence 0001
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Access to conditions

Select this checkbox

CannotBeChanged

Do not select this checkbox

Multiple issuing

Select this checkbox

Partner-indep.output

Select this checkbox

do not write processing log

Do not select this checkbox

Program OPS_SE_SHP_SEND_MESSAGE
FORM routine CHECK_REPEAT
Default values tab

Dispatch Time

4 Send imedi ately (when saving the

appl i cation)

Transmission Medium

8 Special function

Partner Function

Leave this empty

Communication Strategy

Leave this empty

3. Inthe dialogue structure, select Processing Routines.

4. Make sure that the following entries have been made for the output types:

Processing Routines

Field

Entry

Transmission Medium

Program

OPS_SE_SHP_SEND_MESSAGE

Form Routine

PROCESS
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6.2.8.44 Maintain Output Determination Procedure
(Outbound Delivery)

Procedure

1. Inyour ERP system in Customizing for Logistics Execution, choose ||¢ Shipping » Basic Shipping Functions
Output Control » Output Determination » Maintain Output Determination for Outbound Deliveries
Maintain Output Determination Procedure.

2. Make sure that procedure V10000 has been entered.

3. Inthe dialog structure, select Control Data.

4. Make sure that the following entries have been made for procedure V10000:

Reference Step Overview

Step Condition Counter Condition Type Requirement
<Any avail able step 4 TRDO 440
nunber >

6.2.8.4.5 Assign Output Determination Procedures
(Outbound Delivery)

In this step, you assign output determination procedures to document types. You can also specify an output
type that is to be displayed when the relevant document is displayed or changed.

Prerequisites

You have defined the following:

* Qutput determination procedures
¢ Qutput types

Procedure

1. Inyour ERP system in Customizing for Logistics Execution, choose ||¢ Shipping » Basic Shipping Functions
Output Control » Output Determination » Maintain Output Determination for Outbound Deliveries

Assign Output Determination Procedures
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2. Choose Assign deliveries (header).

3. Inthe overview, assign the output determination procedure as follows:

Assignments

Delivery Type Output Determination Procedure Output Type

LF Qutbound Delivery V10000 TRDO

6.2.8.46 Create Output Condition Records (Outbound
Delivery)

In this step, you link the relevant delivery type with an output type that is configured for the data transfer to TM.

You define the message attributes, for example, processing time or language. From a technical point of view,
you create condition records.

Procedure

1. Inyour ERP system on the SAP Easy Access screen, choose |[» Logistics # Logistics Execution  Master
Data # Output ¥ Shipping # Outbound Deliveries # Create J or call transaction W21.

2. Choose Output Type TRDO.

3. Choose Enter.

4. On the following screen, enter the data as shown in the table below.

Delivery Type Name Medium Date/Time Language

LF Outbound Delivery 8 Special Function 4 Send immediately EN
(when saving the ap-
plication)

5. Note the following:
* Leave the Funct. and Partner fields blank.
* LFisastandard delivery type that is delivered as part of ERP Customizing.

6. Save your entries.
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6.2.8.4.7 Assign Processing Class

In this step you assign the output type to a processing class. This enables the system to send a message as a
repeat message when you delete a delivery.

Prerequisites

You have defined output types.

Procedure

1. Inyour ERP system in Customizing for Logistics Execution, choose |¢ Shipping » Basic Shipping Functions
» Output Control » Assign Processing Class 3.

2. Check that the following entry exists, or create it, if necessary:

Field Value

Application V2

Output Type TRDO

Class CL_SHP_XI _MESSAGE_TRDO

6.2.8.5 Maintain Output Determination for Inbound
Deliveries

You must configure the following settings to send inbound deliveries from ERP to TM. Output determination is
used to create XML messages, which are sent to TM.

TM Integration Guide for DSC Edition
72 PUBLIC Configuration of Cross-System Processes



6.2.8.5.1 Maintain Condition Tables (Inbound Delivery)

In this procedure, you define the combination of fields for which you want to create output condition records
in a condition table. This enables you to control output determination depending on your specific field
combination.

Procedure

1. In Customizing for Logistics Execution, choose |» Shipping # Basic Shipping Functions ¥ Output Control
» Output Determination  Maintain Output Determination for Inbound Deliveries ¥ Define Condition Table for
Inbound Delivery ¥ Create Condition Table for Inbound Delivery .

Choose | Condition ¥ Display 3.

In the Table field, enter condition table 009.
Make sure that the condition table 009 Delivery Type exists.

o A~ w DN

Make sure that the field Delivery Type is assigned to condition table 009.
If that is not the case, create a new condition table for output control as follows:

a. In Customizing for Logistics Execution, choose | Shipping ¥ Basic Shipping Functions  Output
Control » Output Determination » Maintain Output Determination for Inbound Deliveries * Define
Condition Table for Inbound Delivery ¥ Create Condition Table for Inbound Delivery 3.

b. Choose |+ Condition  Create 3.
c. Inthe Table field, enter a name (3-digit number) for your new condition table.

Note that you can only choose names between 900 and 999.

d. Choosel[Enter |
e

Enter a description for the new condition table, for example, Delivery Type.

f. Select the required fields for the condition table from the list of allowed fields, for example, Delivery
Type.

g. Generate the new condition table.

6.2.8.5.2 Maintain Output Types (Inbound Delivery)

Procedure

1. In Customizing for Logistics Execution, choose |# Shipping * Basic Shipping Functions ¥ Output Control
» Output Determination » Maintain Output Determination for Inbound Deliveries ¥ Define Output Types for
Inbound Delivery 3.
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2. Make sure that output type TRDO (Delivery to external TMS) has been created. Otherwise, proceed with the

4.

remainder of this procedure.
3. Enter TRDO with the following data:

Header Area

Output Type

TRDO

Description

COr./Chg TMInt. IDLV

General Data tab page

Access sequence

0001

Access to conditions

Selected

CannotBeChanged Not selected
Multiple issuing Selected
Partner-indep.output Selected

do not write processing log

Not selected

Program

OPS_SE_SHP_SEND MESSAGE

FORM routine

CHECK_REPEAT

Default values tab page

Dispatch Time

4 Send immediately (when saving the application)

Transmission Medium

8 Special function

Partner Function

Blank

Communication Strategy

Blank

In the dialogue structure, select Processing Routines.

5. Make sure that the following entries have been made for the output types:

74

Processing Routines

Field

Entry

Transmission Medium

8

Program

OPS_SE_SHP_SEND_MESSAGE

Form Routine

PROCESS

PUBLIC
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6.2.8.5.3 Maintain Access Sequences (Inbound Delivery)

Prerequisites

You have defined the necessary condition tables.

Context

In this procedure, you check whether the required access sequences are available, or you create access
sequences that you can use to determine the following:

* Which condition tables are used to access condition records

* The sequence of these condition tables

* With which field contents they are read

Procedure

1. In Customizing for Logistics Execution, choose | Shipping # Basic Shipping Functions » Output Control
» Output Determination ¥ Maintain Output Determination for Inbound Deliveries j Define Access Sequence
for Inbound Delivery .

2. Inthe overview, select access sequence 0001 Delivery Type.

3. Select Accesses.

4. Condition table 9 is displayed in the Overview Accesses table and requirement 432 is assigned in the
Requirement column.

If the correct access sequence is not available, create it as follows:

a. In Customizing for Logistics Execution, choose | Shipping ¥ Basic Shipping Functions ¥ Output
Control » Output Determination » Maintain Output Determination for Inbound Deliveries * Define
Access Sequence for Inbound Delivery 3.

b. Switch to edit mode and choose New Entries.

c. Inthe Access Sequences area, create an access sequence by specifying an alphanumeric key (with a
maximum of four characters) and a description.

d. InDescription, enter a description.
In Source, select one of the following sources: Other system (for example, ERP) or Local.

f. Select the row in the Access Sequences table and choose Fields from the dialog structure.

You can define accesses by specifying the access sequence and choosing the corresponding condition
tables.
g. Save your entries.
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6.2.8.5.4 Maintain Output Determination Procedure
(Inbound Delivery)

Procedure

1. Inyour ERP system, navigate to Customizing for Logistics Execution and choose |j» Shipping » Basic
Shipping Functions » Output Control » Output Determination » Maintain Output Determination for Inbound
Deliveries » Maintain Output Determination Procedure

2. Checkthat procedure E10001 - | nbound Del i very exists and select it. If the procedure does not exist,
create it.

3. Inthe dialog structure, select Control Data.

4. Check that the following entries have been made for procedure E10001:

Step Condition Counter Condition Type Requirement
<Any avail abl e step <Any avail abl e TRDO 441
nunber > condi ti on counter>

6.2.8.5.5 Assign Output Determination Procedures
(Inbound Delivery)

In this procedure, you assign output determination procedures to document types. You can also specify an
output type that is to be displayed when the relevant document is displayed or changed.

Prerequisites

You have defined the following:

* Qutput determination procedures
¢ Qutput types

Procedure

1. Inyour ERP system, navigate to Customizing for Logistics Execution and choose |» Shipping
Basic Shipping Functions » Output Control » Output Determination » Maintain Output Determination for

Outbound Deliveries ¥ Assign Output Determination Procedures
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2. Inthe overview, assign the output determination procedure as follows:

Delivery Type Output Determination Procedure Output Type
EL I nbound Delivery E10001 TRDO
i Note

Note that EL is a standard delivery type that is delivered as part of ERP Customizing.

6.2.8.5.6 Create Output Condition Records (Inbound
Delivery)

In this procedure, you link the relevant delivery type with an output type that is configured for the data transfer
to TM. You define the message attributes, for example, the processing time or language. From a technical point
of view, you create condition records.

Procedure

1. Onthe SAP Easy Access screen of your ERP system, choose | Logistics » Logistics Execution » Master
Data » Output » Shipping # Inbound Deliveries j» Create 3 or call transaction M\24.

2. Enter output type TRDO and press .
3. Onthe following screen, enter the data as shown in the table below.

Delivery Type Name Medium Date/Time Language
EL I nbound 8 Speci al 4 Send EN
Delivery Functi on i mredi ately
(when

saving the
appl i cation)

4. Note the following:
* Leave the Funct. and Partner fields blank.
* EL is astandard delivery type that is delivered as part of ERP Customizing.

5. Save your entries.
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6.2.8.5.7 Assign Processing Class

In this step you assign the output type to a processing class. This enables the system to send a message as a
repeat message when you delete a delivery.

Prerequisites

You have defined output types.

Procedure

1. Inyour ERP system, in Customizing for Logistics Execution, choose | Shipping ¥ Basic Shipping Functions
» Output Control  Assign Processing Class 3.

2. Check that the following entry exists, or create it, if necessary:

Field Value

Application E1

Output Type TRDO

Class CL_SHP_XI _MESSAGE_TRDO

6.2.8.6 Order and Delivery Integration

Use

The following documents can be transferred to TM: sales orders, purchase orders, stock transport orders,
returns orders (such as sales returns, vendor returns, and store returns), outbound deliveries, and inbound
deliveries.

Before you can transfer the documents, you have to define the control keys in the respective Customizing
activity and activate the transfer of documents to TM. The settings that you have to configure depend on the
scenario that you want to set up. You also have to configure output determination for the documents.

Integration of Sales Orders, Customer Returns and Corresponding Deliveries
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To configure this integration scenario in your ERP system, you configure the settings for sales documents such
that corresponding deliveries are also sent to TM. You configure the settings as follows:

* Defining Control Keys for Document Transfer
You must select the SO to TMS checkbox and the Outbd Del. checkbox for the control key. If you want to
schedule sales orders in TM synchronously, select the SO Sched checkbox.

* Activating Transfer of Sales Documents
You assign the control key to your sales document types.

Integration of Purchase Orders, Stock Transport Orders, Return Purchase Orders, Return Stock Transport
Orders, and Corresponding Deliveries

To configure this integration scenario in your ERP system, you configure the settings for purchase documents
such that corresponding deliveries are also sent to TM. You configure the settings as follows:

* Defining Control Keys for Document Transfer
You must select the PO to TMS checkbox and the Inbd Del. checkbox for the control key.
If you want to transfer confirmation data of external purchase orders to TM as confirmed quantities you
must select the PO Conf. checkbox as well.

* Activating Transfer of Purchase Orders
You assign the control key to your purchase document types.

Integration of ERP Orders Without Sending Deliveries to TM

To configure this integration scenario in your ERP system, you configure the settings for orders such that the
corresponding deliveries are not sent to TM. You configure the settings as follows:

¢ Defining Control Keys for Document Transfer
You must select the SO to TMS checkbox for the control key, but you do not select the Outbd Del.
checkbox. In the same way, you select the PO to TMS checkbox for the control key for purchase
documents, but you do not select the Inbd Del. checkbox.

* Activating Transfer of Sales Documents
You assign the control key.for sales documents to your sales document types.

* Activating Transfer of Purchase Orders
You assign the control key for purchase documents to your purchase document types.

Integration of ERP Deliveries Without Sending Orders to TM

To configure this integration scenario in your ERP system, you configure settings for deliveries such that the
preceding order documents are not sent to TM. You configure the settings as follows:

¢ Defining Control Keys for Document Transfer
You must select the Outbd Del. checkbox for the control key for outbound deliveries and the Inbd Del.
checkbox for the control key for inbound deliveries. The control keys must not have the SO to TM checkbox
or the PO to TM checkbox selected.

* Activating Transfer of Delivery Documents
You assign the control key to your delivery document types.
For information about the necessary message control settings in ERP, see Prerequisites for Order and Delivery
Integration in the Product Assistance for SAP S/4HANA on SAP Help Portal under | Enterprise Business
Applications ¥ Supply Chain j Logistics Cross Topics # Logistics — General (LO) ¥ Integration of SAP ERP with
SAP Transportation Management ¥ Integration: Order and Delivery Processing — SAP TM # Prerequisites for
Order and Delivery Integration 3.
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Integration Business Add-Ins (BAdIs)

The following BAdIs are available in Customizing for Integration with Other SAP Components under

|\ Transportation Management ¥ Order Integration ¥ Business Add-Ins (BAdls) 2

* BAdI: Sales Document Integration with TM
* BAdI: Purchase Order Integration with TM
* BAdI: Delivery Integration with TM

You can use these BAdIs to define the control key and the technical settings for transportation management
according to your own logic, overriding the Customizing settings. The BAdIs are called when a document is

saved for the first time.

More Information

To improve understanding and provide a better overview, the following tables show the different messages that
are used to transfer order-related and delivery-related data between ERP and TM.

Message Flow Order Integration

ERP Orders and Order-Based Transportation Requirements

Message

Description

SLO Transportati onRequest Sui t eRequest _Qut

Send created or changed sales orders from ERP to TM

POP_Tr ansport ati onRequest Sui t eRequest _Qut

Send created or changed purchase and stock transport or-
ders and their returns from ERP to TM

CRP_Transportati onRequest Sui t eRequest _Qut

Send created or changed customer returns from ERP to TM

| ntraconpanyTransport ati onRequest Request _I n

Receive creation or change requests for order-based trans-
portation requirements in TM

SLO Transportati onRequest Sui t eCancel | ati onReq
uest _Qut

Send cancellation requests for sales orders from ERP to TM

POP_Tr ansport ati onRequest Sui t eCancel | ati onReq
uest _Qut

Send cancellation requests for purchase and stock transport
orders and their returns from ERP to TM

CRP_Transportati onRequest Sui t eCancel | ati onReq
uest _Qut

Send cancellation requests for customer returns from ERP
to TM

I nt raconpanyTransportati onRequest Cancel | ati on
Request _in

Cancel requests for order-based transportation require-
mentsin TM
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Simulation of Sales Orders

Message

Description

Transportati onRequest Sui t eSi nul at eRequest Conf
i rmation_Qut

Send simulation requests for created or changed sales or-
ders from ERP to TM

I nt raconpanyTransportati onRequest Si mul at eRequ
estConfirmation_In

Receive creation or change requests for simulation-based
order-based transportation requirements in TM

ERP Deliveries and Delivery-Based Transportation Requirements

Message

Description

Qut boundDel i ver yBul kCr eat eRequest _CQut

Send creation requests for outbound deliveries from TM to
ERP

Qut boundDel i ver yBul kCr eat eRequest _I n

Receive creation requests for outbound deliveries in ERP

Qut boundDel i ver yBul kConfi r mati on_Qut

Send confirmations of requests for outbound deliveries from
ERPto TM

Qut boundDel i ver yBul kConfi rmation_In

Receive confirmations of requests for outbound deliveries in
™

CDP_Transport ati onRequest Sui t eRequest _Qut

Send created or changed outbound deliveries from ERP to
™

CDP_Transport ati onRequest Sui t eCancel | ati onReq
uest _Qut

Send cancellation requests for outbound deliveries from ERP
to T™M

I nboundDel i ver yCr eat eRequest _Qut

Send creation requests for inbound deliveries from TM to
ERP

| nboundDel i ver yCr eat eRequest _I n

Receive creation requests for inbound deliveries in ERP

| nboundDel i veryConfirnation_Qut_V1

Send confirmations of requests for inbound deliveries from
ERP to TM

| nboundDel i veryConfirnation_In_V1

Receive confirmations of requests for inbound deliveries in
™

| DP_Transport ati onRequest Sui t eRequest _Qut

Send created or changed inbound deliveries from ERP to TM

| DP_Transport ati onRequest Sui t eCancel | ati onReq
uest _Qut

Send cancellation requests for inbound deliveries from ERP
to TM

I nt raconpanyTransportati onRequest Request _I n

Receive creation or change requests for delivery-based
transportation requirements in T™M
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ERP Deliveries and Delivery-Based Transportation Requirements

Message

Description

I ntraconpanyTransport ati onRequest Cancel | ati on
Request _in

Receive cancellation requests for delivery-based transporta-
tion requirements in TM

Qut boundDel i ver yERPSpl i t Request _Qut _V1

Send split requests for outbound deliveries from TM to ERP

Qut boundDel i ver yERPSpl i t Request _I n_V1

Receive split requests for outbound deliveries in ERP

Qut boundDel i ver yERPSpl i t Confirmation_Qut V1

Send confirmations of split requests for outbound deliveries
from ERP to TM

Qut boundDel i ver yERPSpl i t Confirmati on_I n_V1

Receive confirmations of split requests for outbound deliver-
iesin TM

Qut boundDel i ver yUpdat eRequest _Qut

Send update requests for outbound deliveries from TM to
ERP

Qut boundDel i ver yUpdat eRequest _I n

Receive update requests for outbound deliveries in ERP

Qut boundDel i veryConfirmati on_Qut_V1

Send confirmations of update requests for outbound deliver-
ies from ERP to TM

Qut boundDel i veryConfirmation_I n_V1

Receive confirmations of update requests for outbound de-
liveries in TM

SAP TM Document Flow in SAP ERP

Message

Description

Busi nessDocunent FI owTM nf or mat i onbyBusi nessCb
j ect Ref erenceQuer yResponse_Qut

Send request for TM business document flow from ERP to
™

Busi nessDocunent FI owTM nf or mat i onbyBusi nessCb
j ect Ref erenceQuer yResponse_I n

Receive requests for TM business document flow in TM

6.2.8.6.1

Activate Transfer of Sales Documents

In this procedure, you define the sales documents that you want to transfer from ERP to TM. You define the
control key that is to be used and the number of the TM system to which you want to transfer the sales
documents. This information is dependent on the sales area, sales document type, and shipping condition. You
can also specify a technical transportation management number that distinguishes the receiving TM system.
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Prerequisites

You have defined the necessary control keys.

Context

The control key determines which documents in the document chain are to be transferred to TM.

Procedure

1. In Customizing for Integration with Other SAP Components, choose |+ Transportation Management # Order
Integration ¥ Activate Transfer of Sales Documents 3.

2. Make sure that an entry exists for the sales organization, distribution channel, divison, sales document
type, and shipping condition you need, and that the control key matches. If necessary, specify the technical
number of the TM system as well.

6.2.8.6.2 Activate Transfer of Purchase Orders

In this procedure, you define the purchase orders that you want to transfer from ERP to TM. You define the
control key that is to be used and the number of the TM system to which you want to transfer the purchase
orders. This information is dependent on the purchasing organization, purchasing group, and purchasing order
type. You can also specify a technical transportation management number that distinguishes the receiving TM
system.

Prerequisites

You have defined the necessary control keys.

Context

The control key determines which documents in the document chain are to be transferred to TM.
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Procedure

1. In Customizing for Integration with Other SAP Components, choose | Transportation Management » Order
Integration » Activate Transfer of Purchase Orders 3.

2. Make sure that an entry exists for the purchasing organization, purchasing group, and purchase order type
you need, and that the control key matches. If necessary, specify the technical number of the TM system
as well.

6.2.8.6.3 Activate Transfer of Delivery Documents

In this procedure, you define the delivery documents that you want to transfer from ERP to TM. You define the
control key that is to be used and the number of the TM system to which you want to transfer the delivery
documents. This information is dependent on the shipping point, the delivery type, and the shipping condition.
You can also specify a technical transportation management number that distinguishes the receiving TM
system.

Prerequisites

You have defined the necessary control keys.

Context

The control key determines which documents in the document chain are to be transferred to TM.

i Note

You can also activate the transfer of delivery documents using the control key that is assigned to the
preceding document in the document chain (for example, a sales order or a purchase order). In this case,
the delivery inherits the control key from the preceding document and the system ignores any settings that
you configure in this procedure.

Procedure

1. In Customizing for Integration with Other SAP Components, choose |» Transportation Management » Order
Integration ¥ Activate Transfer of Delivery Documents. 4.

2. Make sure that an entry exists for the shipping point, delivery type, and shipping condition you need, and
that the control key matches. If necessary, specify the technical number of the TM system as well.
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6.2.9 Define Organizational Structure

Context

In TM, you use this process to create organizational models for the organizations that take partin
transportation processes. You can create the organizational models according to a predefined hierarchical
structure. You can assign employees who take part in workflow processes to the organizational units.

i Note

For more information, see Organizational Management and Creation of Organizational Models in
the Product Assistance for SAP S/4HANA on the SAP Help Portal under || Enterprise Business
Applications # Supply Chain ¥ Delivery and Transportation ¥ Transportation Management (TM) » Master

Data » Organizational Management » Creation of Organizational Models .

Procedure

1. Inyour TM system, start transaction PPOCE (Create Organization and Staffing) and create the required
organizational structure.

2. Alternatively, in Customizing for Transportation Management, go to | Master Data ¥ Organizational

Management » Organizational Model » Create and Merge Organizational Hierarchy J or use the program /
SCMIMS/ TRANS_ORG_MODEL to copy the relevant entries from the ERP organizational structure.

i Note

Regardless of the chosen approach in regard to the organizational structure creation, you must ensure
that the organizational units relevant for transportation charge management have assigned a BSG Org.
Unit that will enable the relevant interfaces to identify the correct ERP organizational unit.

i Note

For further information, see SAP Note 2550444 F .
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6.2.10 Define Order-Based Transportation Requirement
Types

Context

An order-based transportation requirement (OTR) is a technical prerequisite in ERP order integration that
captures the most important and relevant data contained in the ERP order and is further used in TM to build
the freight units based on the information available in this technical container.

For more information, see Order-Based Transportation Requirement in the Product Assistance for SAP S/
4HANA on the SAP Help Portal under |» Enterprise Business Applications » Supply Chain » Delivery and
Transportation  Transportation Management (TM) ¥ Logistics Integration # External TM System Integration
» Integration of ERP Orders and Deliveries in Transp. Planning ¥ Integration of ERP Orders ¥ Order-Based

Transportation Requirement .

Procedure

1. Inyour TM system, in Customizing for Transportation Management, choose | Integration » Logistics
Integration ¥ External TM System Integration  Order-Based Transportation Requirement j Define Order-
Based Transportation Requirement Types 3.

2. Choose New Entries and create a new document type, according to your requirements.

i Note

Ensure that the most critical settings for the integration are maintained:
* Default Type (one default OTR type must exist)
* Automatic Freight Unit Building
* Propagate Changes
* Default Units of Measure
* Plan on Req/Cnf. Qty
* freight Unit Building Rule or FU Building Rule Condition.
For enforcing business rules or scenario-based splitting of the OTR determination, you can define a

condition of type / SCMIMs/ OTR_TYPE where you may maintain various criteria for determining the
relevant OTR type.
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6.2.11 Define Delivery-Based Transportation Requirement

Types

Context

A delivery-based transportation requirement (DTR) is a technical prerequisite in ERP order integration that

captures the most important and relevant data contained in the ERP delivery and is further used in TM to build
the freight units based on the information available in this technical container.

For more information, see Delivery-Based Transportation Requirement.

Procedure

1. Inyour TM system, in Customizing for Transportation Management, choose [+ Integration j» Logistics

Integration ¥ External TM System Integration # Delivery-Based Transportation Requirement ¥ Define

Delivery-Based Transportation Requirement Types 3.

2. Choose New Entries and create a new document type, according to your requirements.

i Note

Ensure that the most critical settings for the integration are maintained:

Default Type (one default DTR type must exist)
Automatic Freight Unit Building

Propagate Changes

Default Units of Measure

Plan on Req/Cnf. Qty

Freight Unit Building Rule or FU Building Rule Condition.

For enforcing business rules or scenario-based splitting of the DTR determination, you can define a
condition of type / SCMIMs/ DTR_TYPE where you may maintain various criteria for determining the
relevant DTR type.
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7 Perform Initial Load of Master Data from
ERP to TM System

71 Execute Initial Transfer of Business Partners

You use this process to execute the transfer of business partners from your ERP to your TM system. You can
choose to transfer the entire set of business partner data; however, only the minimum information required to
be transferred to TM is described here.

Context

i Note

For more information, see Execution of Data Replication in the Product Assistance for SAP S/4HANA
on the SAP Help Portal under |+ Cross Components # Data Replication Framework # Execution of Data
Replication 3.

Procedure

1. Logonto your ERP system.
2. Launch transaction DRFOUT (Define Filter Criteria).

3. Select a DRF replication model and enter the following data:

Field Value

Replication Model The name of your replication model

Outbound Implementation 986_3 (Outbound Impl. for BP/REL via Services)
|} Replication Mode > Manual } Select this radio button

|} Options for Report Control > Test Run Only } Deselect this checkbox

4. Choose Manual Active Filter Criteria and enter the following selection criteria:

Field Operator Value
Business Partner (Include): = (Single Value) The IDs of the business partners to be
transferred
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Field Operator Value

BPSelectionMode (Include): = (Single Value) 1 Business Partners only

BP Role (Include): = (Single Value) FLCUOO
FLCUOL
FLVNOO
FLVNO1

Company Code (Vendor Company (Exclude): [*] (Pattern) *

Code Data for DRF Node Filter)

Purchasing Organization (Exclude): [*] (Pattern) *

Company Code (Customer Company (Exclude): [*] (Pattern) *

Code Data for DRF Node Filter)

Sales Organization (Exclude): [*] (Pattern) *

Distribution Channel (Exclude): [*] (Pattern) *

Division (Exclude): [*] (Pattern) *

5. Choose Execute.

7.2 Execute Initial Transfer of Shipping Points and Plants

You use this process to execute the transfer of shipping points and plants from your ERP to your TM system.

Context

i Note

For more information, see Execution of Data Replication in the Product Assistance for SAP S/4HANA
on the SAP Help Portal under |* Cross Components » Data Replication Framework » Execution of Data

Replication 3.

Procedure

1. Logonto your ERP system.
2. Launch transaction DRFOUT (Define Filter Criteria).

3. Select a DRF replication model and enter the following data:
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Field Value

Replication Model The name of your replication model

Outbound Implementation DRF_0045_L (Shipping Point/Receiving Point)
|+ Replication Mode ¥ Initialization 3 Select this radio button

|+ Options for Report Control # Test Run Only 4 Deselect this checkbox

4. Choose Execute.

5. Select a DRF replication model and enter the following data:

Field Value

Replication Model The name of your replication model

Outbound Implementation 464_L (Plant to Location Replication from ECC to S/4
™)

|} Replication Mode > Initialization } Select this radio button

|+ Options for Report Control » Test Run Only 4 Deselect this checkbox

6. Choose Execute.

7.3 Execute Initial Transfer of Materials

You use this process to execute the transfer of materials from your ERP to your TM system.

Context

i Note

If your ERP system is an SAP S/4HANA system, you can use a Web service for material master replication.

i Note

For more information, see Execution of Data Replication in the Product Assistance for SAP S/4HANA
on the SAP Help Portal under |+ Cross Components # Data Replication Framework # Execution of Data
Replication .
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Procedure

1. Log on to your ERP system.

2. Launch transaction DRFOUT (Define Filter Criteria).

3. Select a DRF replication model and enter the following data:

Field

Value

Replication Model

The name of your replication model

Outbound Implementation

If your ERP system is an SAP ERP system, enter
194_1 (Material via IDoc (ME - enhanced
Filter Object))

If your ERP system is an SAP S/4HANA system, enter
194_3 (Qutbound Inpl. for Product via
Servi ces)

|+ Replication Mode ¥ Initialization

Select this radio button

|+ Options for Report Control # Test Run Only 4

Deselect this checkbox

4. Choose Execute.
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8 Monitoring and Error Handling in ERP-TM
Integration

Monitor the data that is replicated through the Data Replication Framework (DRF) to check whether your
ERP-TM integration scenario is configured correctly. Additionally, you can monitor the transactional data
transfer between ERP and TM systems.

8.1 Monitor XML Messages

Monitor inbound and outbound XML message transfer between ERP and TM.

Context

You use Web services to transfer master data from ERP to TM or transactional data between ERP and TM and
vice versa.

Procedure

1. Calltransaction SRT_MONI (Web Service Utilities: Message Monitor).
2. Enter your selection criteria.

3. Execute the report.

Display the status monitor for XML-based communication records and allows you to display and trace
messages. You also have the option to process messages with errors in the external application (for
example, in TM).

i Note

Processing errors of selected messages may not always be visible in the monitor’s status or processing
status fields. Due to design, errors in various services are included in their respective confirmation
message. Please make sure that the confirmation messages have been configured in your system and
evaluate fault messages contained in them.
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8.2 Monitor IDocs

Monitor inbound IDocs to check whether data has been replicated successfully.

Context

You use IDocs to replicate materials.

Procedure

1. Calltransaction WEO2 (/Doc List) or transaction BD87 (Select IDocs).
2. Enter your selection criteria.

3. Execute the report.

Transaction WEO2 displays a list of IDocs and allows you to drill down into data records and status records,
for example.

Transaction BD87 displays the status monitor for ALE records and allows you to display and trace IDocs.
You also have the option to process selected IDocs again after resolving an error indicated by the IDoc
status records.

8.3 Activate Forward Error Handling and Error and Conflict
Handler

Forward Error Handling (FEH) is a concept that enables errors detected during the execution of asynchronous
services to be processed on the provider side. This concept is implemented using the Error and Conflict
Handler (ECH).

Context

You use the ECH to control the system response in case of errors and conflicts in service operations. You can
define whether service operations are executed again or terminated after errors and conflicts. This is especially
helpful, for example, for detecting errors during message exchange between your ERP and TM systems.

i Note

For more information, see the following pages:
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* Forward Error Handling in the Product Assistance for SAP S/4HANA on the SAP Help Portal under
| Enterprise Technology # Enterprise Services » Technical Concepts » Forward Error Handling 4.

* Error and Conflict Handler (CA-FS-ECH) in the SAP Library for SAP Netweaver on the SAP Help Portal
under |+ SAP NetWeaver Library: Function-Oriented View # Application Server ¥ Application Server
ABAP » Other Services ¥ Services for Business Users ¥ Error and Conflict Handler (CA-FS-ECH) 3.

Procedure

1. Inyour ERP system, go to Customizing for Cross-Application Components. Choose |» Processes and Tools
for Enterprise Applications } Enterprise Services  Error and Conflict Handler » Activate Error and Conflict
Handler 3.

2. Select the Activated checkbox and save.

8.4 Troubleshooting SOA Manager and WSRM
Communication

Context

In the case of WSRM communication where one or more messages cannot be found in the SRT_MONI , but
instead they are found in the SXI _MONI TOR, check the Web service configuration for the specific consumer
proxy. Particularly check the logical receiver determination, if needed for this consumer proxy.
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9 Further Information

Information on ERP

* Forinformation on SAP ERP, including the SAP Library and guides, see the SAP Help Portal at http://
help.sap.com/erp.

¢ Forinformation on SAP S/4HANA, including Product Assistance and guides, see the SAP Help Portal at
http://help.sap.com/s4hana_op.

You can select your release from the the drop-down menu there.

i Note

This guide provides links and navigation paths to the most up-to-date version of the documentation on the
SAP Help Portal. Therefore, whenever you access information using these links, you should choose your
specific release from the drop-down menu there.

Similarly, if you are running an SAP ERP system and a link to further information leads you to the Product
Assistance for SAP S/4HANA, you should substitute that with the SAP Library for SAP ERP. Apart from the
product names, the navigation paths are the same.

Informationon TM

For information about TM, see Transportation Management (TM) in the Product Assistance for SAP S/4HANA
on the SAP Help Portal under |+ Enterprise Business Applications ¥ Supply Chain j Delivery and Transportation
» Transportation Management (TM) 3.

For information about setting up TM, see the information for SAP S/4HANA on the SAP Help Portal at http:/
help.sap.com/s4hana_op, where there is also TM-specific information in the Installation Guide there.

For information about setting up Web Services Reliable Messaging (WSRM) see the WS/RM Integration Guide
for SAP Transportation Management on the SAP Help Portal at http://help.sap.com/tm under Configuration.

In SAP Note 2714892#% , you can find information about the deployment options for TM.

In SAP Note 2769186/, you can find information on moving from SAP Transportation Management (SAP TM)
to Transportation Management in SAP S/4HANA (TM in SAP S/4HANA). Chapter 22 focuses on master data
distribution from SAP ERP to SAP S/4HANA with DRF.

Information about the enterprise services and additional Enterprise Services Repository (ES Repository)
content for TM is available at Enterprise Services and ESR Content.
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ERP-TM Integration

For information on integrating orders and deliveries from external source systems such as SAP ERP or an
external SAP S/4HANA system, see External TM System Integration in the Product Assistance for SAP

S/4HANA on the SAP Help Portal under |+ Enterprise Business Applications ¥ Supply Chain ¥ Delivery and
Transportation ¥ Transportation Management (TM) ¥ Logistics Integration » External TM System Integration 3.

For release information on TM, including information about how TM integrates into the embedded applications
in SAP S/4HANA and also supports side-by-side scenarios, please refer to chapter 1 of SAP Note 3083725 .

For information about the posting of freight settlement documents in side-by-side scenarios with SAP S/4
HANA 1709 FPS02, please see SAP Note 2640069 .

For more information about system integration, see the following SAP Notes:

*  SAP Note 1552355/ ERP Integration: System Connection between ERP and TM
*  SAP Note 1530240 FAQ for ERP-TM Integration
*  SAP Note 1588450 FAQ for ERP-TM Logistics Integration

Integration with Warehousing and Other Capabilities

See Integration of SAP S/4HANA Supply Chain for Extended Warehouse Management and SAP S/4HANA
Supply Chain for Transportation Management in One Client as Part of the SAP Digital Supply Chain
Management, Edition for SAP S/4HANA available at http://help.sap.com/dscedition under Integrate.

See also SAP Note 2812981#% for information about using TM and decentralized EWM in the same SAP
S/4HANA system and client.

For information on integrating TM with EWM, SAP Event Management, and SAP Global Trade Services,

see Integration in the Product Assistance for SAP S/4HANA on the SAP Help Portal under ||» Enterprise
Business Applications # Supply Chain ¥ Delivery and Transportation » Transportation Management (TM)
Integration 3.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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